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Seafloor Tutorial
This tutorial collection is specific to the Seafloor functionality in Geocap, however a few chapters are of a general
character and may be duplicated in other tutorials. Training data will be used as an example project, but other
projects may be used instead when doing the exercises.

The order of the tutorials is more or less describing the suggested order in which a real project would be done. In
this set of tutorials we cover:
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A. Getting Started with Geocap Seafloor

Introduction

Geocap is a software for mapping and modeling geoscientific data, designed with focus on interactivity and
flexible control of visualization and manipulation. Geocap is operated through projects. The project "holds" the
data in a folder-like structure, similar to Windows "File Explorer". All datasets are "children" of either a folder or
another dataset. Geocap offers different project templates, giving you a pre-defined folder structure that fits your
workflow for a specific type of work. In this tutorial collection we are going to use the Seafloor project template.

Data visualization and manipulation is operated through commands. Commands can be used to display datasets
in the graphics window, manipulate existing datasets or to generate new datasets. The Geocap Sefloor module
offers a range of commands for processing hydrographic data.These commands are available from the Seafloor
Main Menu or if you right click a dataset or folder in the project.

All the project data is visualized in the graphics window and by using the mouse it is possible to pan, zoom,
rotate, spin, scale z-axis and so on.

This section will guide you through the basics of opening a project, explore and display the project data and
navigate in the graphics window.

Exercises

Start Geocap on Windows 7
Start Geocap on Windows 8.1
Set working directory and auto save
Open the Seafloor_Demo project
Explore the project folder structure
Display data
Navigate using the mouse

 

 

Starting Geocap

Exercise

Start Geocap on Windows 7

On your start menu click Start > All programs > Geocap > Geocap 7.x.x - 64 > Geocap 7.x.x - 64

 

 

Exercise

Start Geocap on Windows 8.1

Go to the    .Start screen
Near the lower-left corner of the Start screen, click the arrow down and go to the  . Apps view
In the search field in the upper right corner, enter the text  .Geocap
All the files installed by the installation wizard will be listed. (It is also possible to find the
Geocap 7.x.x group without using the search field.)
Click on the Geocap 7.x.x - 64 entry to start the program.

-
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1.  
2.  
3.  
4.  
5.  
6.  
7.  

User Documentation

Parts of the user documentation is found under the Help pulldown. There rest is found here: http://www.geocap.
. Read briefly through the documentation to get an understanding of what you can expect to find in theno/doc

documents.

The user documentations consists of:

User Guide with detailed descriptions of Geocap usage.
Reference manual with syntax and details of the commands in the Geocap scripting language.
Installation Guide with details on installation, dongle drivers etc.
Release Notes contains incremental updates and bug fix descriptions as well as major releases.
Articles is a collection of articles on various topics that still is not included in the documentation.
Tutorials contains thematic tutorials on products. The General tutorials mainly contains topics that are
put in a better context within the more specialized product tutorials.
FAQ is a list of Frequently asked questions, with their corresponding answers.

 

Initial Setup

Geocap comes with a range of settings which can modified to make it easier to work with. One of these settings
is the working directory which is the folder Geocap will open every time you browse for something. We will now
set this directory and we will also turn on auto save.

 

Exercise

Set working directory and auto save

Click Tools > Options
Click the  icon for thebrowse  Working Directory.
Select the folder and click Geocap1  Select folder
Click on Projects
Check the box Automatically save all projects at regular time intervals
Set the  to Time interval 5
Click OK

-

http://www.geocap.no/doc
http://www.geocap.no/doc
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1.  
2.  
3.  

Geocap Project

The Seafloor_Demo project is built using the Seafloor project template. This template consists of three main top
level folders; 1. Survey Data, 2. Charts, 3. Geographics. The number ahead of the folder name is to have a
logical sorting in the project tree. The Survey Data folder contains the imported data, like multibeam data, xyz
points (soundings) or single beam data. Within the Charts folder the survey data can be extracted and
processed within certian areas of interest. We are now going to open the Seafloor_Demo project and look closer
at this project structure.

 

Exercise

Open the Seafloor_Demo project

Click  File > Open > Project
Browse to the location of the Seafloor_Demo project. ( )Geocap1/Projects/Seafloor_Demo/db
Select the  file and click . A window similar to the one below willSeafloor_Demo.db Open
appear.

An open project

 

 

  

Tip
Next time you can open the project by going to .File > Recent Projects
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1.  
2.  

Pressing the small triangles (or '+' in other Windows versions) to the left of a folder will display the folder's
contents. Datasets and folders are organized very similarly to a file tree structure. A folder can contain datasets
or other folders.

 

The Geocap Project structure and data items shown in List Mode (left) and in Tree mode (right).

In the next exercise we are going to explore how the Seafloor project is structured. Taking notice of how folders
and datasets are organized. Datasets and folders can be cut, copied, pasted, renamed and deleted. This is
performed from the popup menu which appears when right-clicking a dataset. The right click popup menu also
contains   which may be executed on the datasets.commands

 

Exercise

Explore the project folder structure

Expand the different folders and observe the sub folders and datasets
Right click on folders and datasets and look at the right-click menus.

-

Note that there are two "modes" of the project view. Switch between these two by clicking on the tabs; Li
and .  view sorts folder content into a separate window, while  view sorts everything intost Tree List Tree

the tree itself.

A Geocap project is stored in a folder on your computer. The project consist of a   file, which".db"
contains information about the project tree, and several files which contain the data sets. You should let
Geocap manage the files in the project folder and should not store other files in this folder.

If you want to make a backup of your projects, or if you want to exchange Geocap projects with other
Geocap users you may zip the project folder with all the underlaying datasets into one file. This is
convenient for sending e.g. to .support@geocap.no
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2.  

3.  

4.  

5.  

6.  

Displaying Data

By right clicking a dataset a range of different visualization commands is made available. For each type of
dataset Geocap will have a default command. This is the command which will be used when ticking the
checkbox next to a dataset. We are now going to display the different datasets in the project using the default
command.

Exercise

Display data

Display the various datasets in the project

Locate a grid dataset (structured points) e.g. 2. Charts/Multibeam_Area/Seafloor
Right click the dataset and select . This will make the display window center theZoom to Data
graphics window around the dataset.
Right click the dataset again and try a display command e.g. , , Display Map Data Lod Grid

.Display
Display some of the lines (Boundary and Frame) under the  charts byMultibeam_Area
right-clicking and selecting the command .Display
Check, and uncheck the checkboxes to the left of the displayed items and observe that this
toggles displayed objects on/off. You can also check and uncheck the folders containing
displayed items.
Items can also be displayed double clicking on one of the commands in the Toolbox (Item,
Schema and Shared commands) 

-

Note that by checking and unchecking the upper level folder , or  all datasets2. Charts Multibeam_Area
displayed under this folder are shown and hidden.
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1.  

2.  

3.  
4.  
5.  

6.  
7.  

Navigating in the 3D window

Now that we have displayed some of our data we can start navigating around the Atlantis continental
shelf. Geocap is best operated using a three-button mouse with a wheel, see picture below. A two-button mouse
or using the Touch-pad is possible but not recommended. Navigating in the 3D graphics window is done by
pressing one of the mouse buttons while the cursor is in the graphics window, and moving the mouse while
keeping the button pressed.

Rotate - Press left mouse button + move
Pan - Press middle mouse button (wheel) + move or Shift + left mouse button + move
Zoom - Press right mouse button + move
Scale Z - Scroll mouse wheel 
Spin - Ctrl + press left mouse button + move

The mouse buttons

Exercise

Navigate using the mouse

Zoom in close to one of the bathymetric profiles displayed by press  andright mouse button
moving the mouse upwards.
Pan along the seabed surface by pressing the  (wheel) and moving themiddle mouse button
mouse in any direction.
Zoom out again by press right mouse button and moving the mouse downwards.
Rotate the displayed data by pressing the  and moving the mouse.left mouse button
Spin the data by holding down  on your keyboard, pressing the  andCtrl  left mouse button
moving the mouse.
Now try to increase the  by  upwards.z-scale scrolling the mouse wheel
Move around the 3D model an practice these elements for a few minutes.

Tip
The focal point is the center of the display and the point of rotation. Change the focal point by
positioning the mouse cursor on a desired point in the display window and press the  key onX
the keyboard.
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B. Seafloor Main Menu (Extract from User Guide)

In this section:

Introduction
How to open the Seafloor Main Menu
The Content of the Seafloor Main Menu
Menu bar options (File, Edit, Help)
The Current Project part
The Working with Survey Data part
The Working with Charts part

Introduction

The   is a collection of commands and project properties in a Geocap Seafloor project. TheSeafloor Main Menu
most frequently used commands are accessible through this menu, which will make it easier for new users to
operate the Seafloor user interface. However, these and more commands are also available from the project
interface.

 

The Seafloor Main Menu.

-
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How to open the Seafloor Main Menu

To open the   it is required that the   is loaded, and that requires that theSeafloor Main Menu Seafloor package
license file contains one of the features for loading the package. 
The Seafloor package is loaded either on startup of Geocap, or on the   menu, click the   menu. InTools Options
the menu that appears, click  , and then select   in the right hand part of the menu.Plug-ins Seafloor

When the   is loaded, the menu bar in Geocap will contain a   pulldown menu.Seafloor package Seafloor

The Seafloor pull down in the Geocap menu bar

 

On the   menu, click  .Seafloor Seafloor Main Menu

Open the menu

Then the   is opened (see figure above).Seafloor Main Menu

For all actions in this menu it is required to load a project. If no project is loaded, the message "No project is
currently loaded into Geocap" will appear. Then a description on how to load a project follows.

 

The Content of the Seafloor Main Menu

The   is divided in four parts, the  , the   part, the Seafloor Main Menu menu bar Current project Working with
 part, and the   part.Survey Data Working with Charts

The   has three options: File, Edit, Helpmenu bar
The   part contains information about which project is active, and what coordinate systemCurrent project
the project is using.
The   part is the interface to useful commands for processing survey dataWorking with Survey Data
through the   package.Geocap Seafloor
The   part is the interface to useful commands for processing chart data through the Working with Charts

 package.Geocap Seafloor

 

Menu bar options (File, Edit, Help)

The upper part of the menu is a menu bar with the entries  ,   and  :File Edit Help

The Menu bar

For the actions from menu bar entries, see below.
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File

New - Project... will open the dialog to make a new Geocap (Seafloor) project.
The dialog ends with a question about setting geodetic properties for the project.
New - Survey Data folder... will create a folder of type   from top level in the project.Survey
New - Charts Data folder... will create a folder of type   from top level in the project.Charts
The last two commands are useful if the project does not have a folder of the actual type, or if a more
than one folder of this type is required.

Open - Project... will open any existing Geocap projects in the computer or network.

Recent Projects will give a list of recently opened Geocap projects.

 

Edit

Geodetic settings will open the dialog for setting geodetic properties for the project.
Vessel Configuration Manager will open the dialog for setting vessel properties for all open projects.
This entry will have a meaning only when   are loaded.Multibeam Sonar data
Point Cloud (Multibeam) Editor will open the 3D editing tool for point cloud data (multibeam data) (Multi

). This entry will work both when   and   are loaded.beam Editor Point Cloud data Multibeam Sonar data

Help

Seafloor Main Menu will show the help dialog.

https://geocap.atlassian.net/wiki/display/ug/5.+Multibeam#id-5.Multibeam-MultibeamEditor
https://geocap.atlassian.net/wiki/display/ug/5.+Multibeam#id-5.Multibeam-MultibeamEditor
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Seafloor User Guide will open the Seafloor User Guide documentation as a pdf file.
Refresh Report Menu will open the reports dialog containing the last processing results, if it is closed or
hidden.

 

 

The Current Project part

The   part shows the   project in the  . In Geocap the user can loadCurrent Project active Seafloor Main Menu
several projects at the time.

The Current Project part

All projects are shown in the pulldown menu behind the text  . The pulldown and the the projectProject Name
information is is automatically updated if a project is closed or a new project loaded into Geocap.

The text   indicates that during import of any dataset into Geocap, the dataUsing geodetic settings on import
will be transformed to the project coordinate system. This action is set up in the   menu.Geodetic Settings

To change the coordinate system, find the   menu, and click  .Edit Geodetic Settings

The text   indicates that a coordinate system is defined, but noNot using geodetic settings on import
transformation will be performed during import.

The text   indicates that the project doe not have any coordinate system.No geodetic settings is defined

 

The Working with Survey Data part

The Working with Survey Data part

This part contains tabs for import, display and work with data typically from surveys. The three tabs are:

The XYZ data tab
The Multibeam Sonar tab
The Single Beam tab
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The XYZ data tab

The commands in the XYZ data tab are shortcuts to the commands on a folder of type  . Many of theSoundings
commands are  , which means that the settings in the menu is remembered for each folder.Item Commands

If there are several folders of the same type in the project, a dialog will appear.

The XYZ data tab

Import to XYZ data folder: This command will import data to folders of type  .Soundings

There is also a choice to use the   the   or the   reader.Generic reader, ASCII Column reader NaviModel DB

Display Soundings: This command will display the data in folders of type  .Soundings

Gridding Files: This command will make it possible to do gridding (terrain modelling) of the data in folders of
type  .Soundings

Show file properties: This command will show dataset name, bounding box and number of points of the data in
folders of type  .Soundings

Create XYZ data (soundings) Folder: This command will create a new folder of the type   as aSoundings
subfolder under a folder of type  .Survey

 

The Multibeam Sonar tab

The commands in the Multibeam Sonar tab are shortcuts to the commands on a folder of type  . ManyMultibeam
of the commands are  , which means that the settings in the menu is remembered for eachItem Commands
folder.

If there are several folders of the same type in the project, a dialog will appear.

The Multibeam Sonar tab



Page 13

Import Multibeam Sonar Data: This command will import data to folders of type  .Multibeam

Display Multibeam Data: This command will display the data in folders of type  . Also data set nameMultibeam
and navigation lines can be diplayed.

Gridding Multibeam Data: This command will make it possible to do gridding (terrain modelling) of the data in
folders of type  .Multibeam

Show Survey Line properties: This command will show dataset name, bounding box and number of points of
the data in folders of type  .Multibeam

Create Multibeam Folder: This command will create a new folder of the type   as a subfolder under aMultibeam
folder of type  .Survey

 

The Single Beam tab

The commands in the Single Beam tab are shortcuts to the commands on a folder of type  . ManySingle Beam
of the commands are  , which means that the settings in the menu is remembered for eachItem Commands
folder.

If there are several folders of the same type in the project, a dialog will appear.

The Single Beam tab

Import to Single Beam folder: This command will import data to folders of type  .Single Beam

There is also a choice to use the   or the  .Generic reader ASCII Column reader

Display Soundings: This command will display the data in folders of type  .Single Beam

Gridding Files: This command will make it possible to do gridding (terrain modelling) of the data in folders of
type  .Single Beam

Show file properties: This command will show dataset name, bounding box and number of points of the data in
folders of type  .Single Beam

Create    : This command will create a new folder of the type   as a subfolderSingle Beam Folder Single Beam
under a folder of type  .Survey

-
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The Working with Charts part

The Working with Charts part

This part contains tabs for managing, display and work with data organized in charts (areas of interest). The
three tabs are:

The   tabChart commands
The   tabUtilities
The   tab (Not enabled for Shelf)Utilities (2)

The Chart commands tab

The commands in the Chart commands tab are shortcuts to the commands on folders of type   and onCharts
folders of type  . Many of the commands are  , which means that the settings in the menuChart Item Commands
is remembered for each folder.

If there are several folders of the same type in the project, a dialog will appear.

The Chart commands tab

Create and Modify Chart: This command will create or modify folders of type  .Chart

Extract Soundings: This command will read data stored below a folder of type  , and save the result asSurvey
a   data set in folders of type  .Soundings Chart

:Display Chart Data  This command will display the different data stored in folders of type   If there are.Chart
several   folders in the project, a dialog will appear.Charts

Gridding Chart: This command will work on folders of type  .Chart

The command will read the   dataset and create a digital terrain model (DTM). The result will beSoundings
saved in the same folder as a   data set.Seafloor

Show Chart properties: This command will show properties of the content of folders with type  .Chart
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The Utilities tab

This part contains buttons with commands for analysis of data in a   project. All commands work onSeafloor
folders on type   and on folders of type  .Charts Chart
All commands work on folders on type   and on folders of type  .Charts Chart

If there are several folders of the same type in the project, a dialog will appear.

The Utilities tab

Export Chart Data: This command will export different type of data from folders of type  .Chart

Typical datasets to export are   and   polygons,   (points) and   (DTM).Frame Boundary Soundings Surface

Export Contours: This command will export   data from the   (DTM) data set in folders of type Contours Seafloor
. An option is to export as   instead.Chart Contour Areas

Merge Surfaces: This command will create a new   surface (DTM) for a chart by merging surfaces fromSeafloor
other charts in folders of type  .Chart

Remove Chart Data: With this commands it is possible to remove specific data objects from folders of type Cha
. The command can be specified to  , rt Remove entire chart folder and data Remove specified chart folder

, or  .item(s) Remove empty chart

 

The Utilities (2) tab

This part contains buttons with commands for analysis of data in a   project. All commands work onSeafloor
folders on type   and on folders of type  . This utility is not enabled for Shelf,Charts Chart

If there are several folders of the same type in the project, a dialog will appear.

The Utilities (2) tab
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:Make Outline and Holes  This command will create the outline (boundary) and interior hole polygons for a chart
The polygons can be created from the   (DTM) dataset or from the   (points) dataset..  Seafloor Soundings

Make Profile: This command will create a continuous depth profile (intersection) through the Seafloor (DTM)
data set in folders of type Chart.

Points Classification: This command will anaylyze the Seafloor (DTM) data set in folders of typeChart. The
commands will create new points data sets of types  ,  ,  ,   and  .Shoals Deeps Ridges Saddles Valleys

Points Classification: This command will anaylyze the Seafloor (DTM) data set in folders of typeChart. The
commands will create new points data sets of types  ,  ,  ,   and  .Shoals Deeps Ridges Saddles Valleys

Statistical Point Reduction: This command will reduce the amount of points from one or more input datasets.
The selection method can for instance be priority of the  or depth values. The selection areaMinimum  Maximum 
can be by looking at points inside a  or  . The selected points are always with the originalRectangle  Circle
position and not snapped into any grid structure.
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1.  
2.  
3.  
4.  

5.  
6.  

1.  
2.  

3.  

C. Create a New Seafloor Project

Introduction

Geocap provide empty folder structure for various types of projects. This will give you a starting point to get
organized with your own project. A project template either gives you a ready made folder structure, or it gives
you a suite of folders to choose from.

Exercises

Generate a new and empty Seafloor project
Explore the project settings

The Seafloor project template

Geocap can provide an empty folder structure for Seafloor projects. This will give you a starting point to get
organized with your own Seafloor project. The default folder structure holds empty folders for most of the data
types you will need. If you do not find a suitable folder you can create a new folder for that data. It is also a good
idea to create sub-folders if you have a lot of data, for instance a sub-folder for each survey or for each region.

 

Exercise

Generate a new and empty Seafloor project

In the main menu of Geocap, click Seafloor > Seafloor Main Menu.
In the Seafloor Main Menu click . A new dialog will pop up.File > New > Project
Select the  project template.Seafloor
Type in the name of your project in the  field. The name may consist of letters, numbersName
and spaces, but special characters like [, æ,ø, å, &, /, % ... should be avoided.
Click the  button, and select where you want to store your project on your hard disk.Browse
Click .Finish

You will now be prompted with a window asking you if you want to define the geodetic setting of the
project.

Click .Yes
Check the  box and select  as datum and Use geodetic settings for project WGS84 UTM

 as coordinate system.Zone 32 N
Click .OK

An empty project structure may be used for communicating relevant data to colleagues, or for analysis
and trouble shooting by us. To send parts of a project to us in Geocap Support, even only a single
dataset, you may copy the dataset (or a folder) from your main project and paste it into this empty
project. Then zip and send the disk folder .zip to projectname support@geocap.no

When enabling geodetic settings all data will be converted to these settings on import.
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An empty Seafloor project

Your project will now look like the image above. The idea is that this basic structure is kept. Folders may be
added and data imported, but the original folders should not be renamed or moved, and their schemas should
not be changed. This is because this folder structure is used when new datasets are generated. If an original
folder is not present, it will be recreated.

 

Exercise

Explore the project settings

Click the

icon on the project toolbar to look at the settings. Pay particular attention to . YouGeodetics
can see that the settings you previously entered are stored here. You can also access these
from the Seafloor main menu .Edit > Geodetic Settings
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2.  
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4.  
5.  
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7.  
8.  
9.  

D. Import Data

Introduction

Geocap supports a vast amount of Multibeam Sonar Data, in addition to Single Beam and XYZ data. These
types of datasets are imported in different folders in the  folder.1. Survey Data

Geocap also supports import of sensor files in ASCII format, like Tide, Navigation, Velocity, Gyro, Heave, Roll
and Pitch.

Exercises

Import XYZ data
Import Multibeam Sonar data
Show properties for the Multibeam data
Show properties for the XYZ data

 

Importing

Exercise

Import XYZ data

Click the  tab in the .XYZ data Seafloor Main Menu
Click .Import to XYZ data folder
Click .Generic reader
Click the browse icon and browse to the folder  on disk...\Seafloor_Course\XYZ\Simrad_xyz
Select all files and click .Open
Observe that the  looks ok.File header/information
Keep the  as is.Schema
Click  and the import will start.Execute
After import a dialog will pop up, with information about the import. Click  on this.OK

You should now be able to see your xyz data files in the project folder .1. Survey Data / XYZ data

Imported XYZ files
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1.  
2.  
3.  

4.  
5.  
6.  
7.  

Exercise

Import Multibeam Sonar data

Click the  tab in the .Multibeam Sonar Seafloor Main Menu
Click .Import Multibeam Sonar Data
Click the browse icon and browse to the folder ..\Seafloor_Course\Multibeam Sensor

 on disk.Data\EM_710
Select all files and click .Open
Keep the  as is.Import Options
Click  and the import will start.Execute
After import a dialog will pop up, with information about the import. This report will also be
available in the folder .1. Survey Data / Multibeam /Reports

You should now be able to see your multibeam files in the project folder .1. Survey Data / Multibeam

Imported Multibeam Sonar data

 

 

 

 

-

Read more about the import options by clicking the  icon on the import menu.?

The different import commands are also available on the right-click menus of the  folder and Multibeam
 folder.XYZ data
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1.  
2.  

1.  
2.  

Data properties

After importing it might be valuable to take a look at the properties for the files you just imported, to check the
range, number of points etc.

Exercise

Show properties for the Multibeam data

Click the  tab in the .Multibeam Sonar Seafloor Main Menu
Click . A window containing the properties will pop up.Show Survey Line Properties

Observe that the list contains a row for each file, with X-, Y-, Z-range and number of points. At the
bottom of the window you will see the total range and number of points for all files.

Showing Survey Line Properties

 

 

Exercise

Show properties for the XYZ data

Click the  tab in the .XYZ data Seafloor Main Menu
Click . A window containing the properties will pop up.Show Dataset Properties

Observe that the list contains a row for each file, with X-, Y-, Z-range and number of points. At the
bottom of the window you will see the total range and number of points for all files.

You can copy these properties straight into e.g. Excel. Just select a row, column or the whole table
(Ctrl+A), press Ctrl+C on your keyboard and then Ctrl+V in Excel.

These commands are also available on the  and  folders in the project. You canMultibeam XYZ data
also display the properties from within different command menus, i.e. .Display Multibeam Data
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E. Display Data

Introduction

There are several ways to display multibeam soundings and XYZ data. XYZ datasets has the following display
commands available on their right-click menu;

Display
Display Points
LOD Points Display
Map Data

Multibeam Survey files has the following display commands available on their right click menu;

Display
LOD Points Display
Map Depth
Map Amplitude

In many cases you want to display several datasets together, showing the same range for all the files. The Displ
 and  commands in the  offers an easy interface foray Soundings Display Multibeam Data Seafloor Main Menu

displaying data objects together in different ways. These commands are also available on the right-click on the X
 folder and  folder respectively.YZ data Multibeam

 

 

Exercises

Display XYZ data (Soundings)
Display Multibeam data
Experiment with different display settings
Display filtered data

-

Level Of Detail (LOD) displays points and grids based on the current zoom level. This means that the
resolution increases automatically when you zoom closer, which makes the display of large point clouds
or grid a lot faster.
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1.  
2.  
3.  

4.  

XYZ Data

Exercise

Display XYZ data (Soundings)

Select the  tab on the .XYZ data Seafloor Main Menu
Click .Display Soundings
In the list of datasets, select the XYZ datasets you want to display and make sure the settings
are equal to the image below.
Click .Execute

You should now be able to see the soundings in the graphics window.

 

Displaying XYZ data

-

Selecting datasets works the same way as in a Windows file browser, which means you can hold down 
 or  to select several datasets, or use  to select all.shift ctrl ctrl + a
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Multibeam Data

Exercise

Display Multibeam data

Select the  tab on the .Multibeam Sonar Seafloor Main Menu
Click .Display Multibeam Data
Select the Survey Lines you want to display and make sure the settings are equal to the image
below.
Click .Execute

You should now be able to see the soundings in the graphics window.

 

Displaying multibeam data

Exercise

Experiment with different display settings

Make sure the  menu is open and that all survey lines has been selected.Display Mulitibeam Data
Try this:

Un-check  and click  - Observe that the soundings from each surveyUse color range Execute
line will have different colors.

Set the  to  and click  - Observe that the points size increased.Point marker size 5 Execute

Check the  box and click  - Observe that the navigation line is nowShow navigation Execute
displayed.

Check the  box again and go to the  tab.Use color range Color Table
Check the  box, select  and type in the values  and .Use Color Table Absolute range 50 200
Click  and observe that the mapping range is between 50m and 200m.Execute
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Exercise

Display filtered data

Make sure the  menu is open and that all survey lines has been displayed.Display Mulitibeam Data

Click on the  button.Open Point Flag Visibility Filter

Notice that the flag  has been checked as  and that the flag  hasAll points Normal Deleted
been checked as .Hide

Check the  box for the  flag.Color Deleted

The red points that are now displayed are points that were filtered away during import. This could be
because of missing navigation or that they were flagged as not valid by the multibeam echosounder.
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F. Basic Concepts in Geocap

Introduction

There are a few concepts in Geocap which are important to understand in order to work efficiently with the
software. The main concepts are  ,   and  These concepts willActors Schemas, Geodetic Settings Commands. 
be explained in this section. In addition to this section also talks about toolbars, color tables and keyboard short
cuts.

Exercises

Get familiar with schema commands
Change the default display for seabed surfaces
View the geodetic settings of a dataset
Change the color table on a seabed surface
Display data on the Sticky Surface
Try out the different tools on the toolbar
Try the different keyboard shortcuts

Actors

In display context an   is a graphical term for a visualization unit. A complex display is created by a set of actor ac
.   are shown as child's of datasets and are shown in blue text. In Geocap the basic principle is that ators Actors

display   creates one or several  . It is possible to remove the   and the associated displaycommand actors actors
by right clicking and selecting  .Delete

Visualizations are called actors

Schemas

By default datasets are organized into data types, such as points and lines (polydata), grids (structured points)
etc. These are basic geometric types that contain little information about the domain in which they operate. E.g.
coast lines, bathymetric profiles and boundary polygons are all lines (polydata), but the way we work with these
types of data are very different and so it is only natural to classify them into different categories. This higher level
of classification is made possible by  . schemas

Notice that the dataset types are the same, while the schemas are different

The Geocap modules contains several schemas. For example some of the schemas used in the Shelf Module
are  ,  ,  ,  ,  . You can define the schema of acoast line base line limit line seabed surface sediment thickness
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3.  

dataset in the project by right clicking it, and selecting   in the pop-up menu. The choice of aset schema
dataset´s schema controls which commands you see in the pop-up menu when you right click the dataset. You
may create your own schemas as well as edit existing schemas by selecting   under edit in the mainschemas
menu. You can also edit the commands associated with the schemas.

Commands

Commands are operations which can be performed on a dataset. Commands can for example be used to
display a dataset in the display window, or to generate new datasets. You can even create your own scripted
commands to cater to your specific needs. You execute a command by right clicking the dataset or folder you
want to run it on, and then selecting the relevant command in the pop-up menu.

Commands have two execution modes:   and  . If the execution mode is set to   theDirect Interactive Interactive
commands editor with the front menu will be displayed when you execute the command. This allows you to
adjust various settings that define how the command works. Depending on the command, the menu will consist
of different input settings from simple display settings to complex manipulation options. If the execution mode is
set to   the command will execute with the last active input settings for the command. It is possible to seeDirect
the underlying settings for any command by right clicking it in the   and selecting  .Note that someToolbox Edit
commands does not require input parameters and will therefore display the underlying code when running it in In

 mode.teractive

All commands have a front end panel, and most of them have settings that may be customized.

 
 An example of a command front end panel

Commands can be stored in three categories:

Item commands.
Schema commands.
Shared commands.

You will find the commands sorted into the different categories in the   or on the right-click menu of aToolbox
dataset or a folder. Commands can also be put together in sequence in   to perform visualizations orWorkflows
data operations.

Item commands

An item command is associated with a single dataset or folder in the project. Item commands are stored along
with the project. Therefore, if a project is transferred the item commands will transferred as well. Item commands
typically contain settings that pertain specifically to the dataset to which it belongs.

Schema Commands
A schema command is stored with a schema. All datasets or folders using the same schema share these
commands, which also means that editing these commands will affect all the datasets using this schema. The
schema commands are listed on the right click menu and in the   under  . Toolbox Schema commands

To see if a command is set to  or  mode, look behind the command name. If there areDirect Interactive
ellipsis ( ) behind the name, the command is set to  mode.... Interactive
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Exercise

Get familiar with schema commands

Right click the different datasets in the project, and see how the right click menu changes from
schema to schema.

Shared Commands
Shared Commands are commands which are shared with all datasets and folders. These commands are always
available and listed in the   under  . Toolbox Shared commands

 

Default Commands
The default command is the command that is executed when you tick the box next to a dataset in the project.
By default a dataset will have one of the schema commands as a default command. This can however be
changed to any command.

 

Exercise

Change the default display for seabed surfaces

The seabed surfaces has a default command "Map sea" or something similar.

Click on the  datasets in the  folder.Seabed Grids
In the right-click another command (i.e ) and selectToolbox LOD Grid Display  Set as default

.command
Tick the checkbox next to the  dataset and notice that the new command is executed.Seabed

-

Tip
The  check box lets you decide which commands should be available in the right clickPin to Menu
menu, so it is easy to keep organized.  Try to experiment with this option to manipulate the right click
menu.
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Geodetic settings

In Geocap it is the responsibility of the user to secure that data have the correct   and Datum Coordinate system
, also called a  or . Datasets with the same geographical location but with differentProjection   Geodetic settings
coordinate system will not be displayed in the same location in the graphical window. Thus, you will need to
convert one of the datasets to the other coordinate system.

 

Exercise

View the geodetic settings of a dataset

Right click any dataset in your project and click .Properties
Click on the tab. Geodetics 
Observe the Geodetic settings of the dataset.
Read the warning message.
Click .Close

You will learn how to convert datasets to other projectons later in this tutorial.

Color Tables

Geocap comes with a set of predefined color tables which can be seen in the toolbox. These color tables are of
course customizable, or you can create your own color table from scratch. By default the color tables shown in
the lower right corner of Geocap will be used to display a dataset. You can change these color tables by
selecting one of them, right-click another color table in the toolbox and select  . Activate You can also drag color
tables from the toolbox and drop it onto a displayed dataset in the graphical window.

Exercise

Change the color table on a seabed surface

Visualize a seabed surface.
Click on the tab in the .Color Tables Toolbox

,  and  one of the color tables on the seabed surface.Click drag drop

Sticky Surface

Geocap has a concept where any surface can be set to be  . When a surface is sticky, data like points,sticky
lines or images may be displayed onto that surface. This is mainly done by re-sampling lines and displaying
them a little bit above the sticky surface. When a surface is activated (or set) as a sticky surface, it is copied to
workspace under the name  .sticky_surface

Exercise

Display data on the Sticky Surface

Right-click on a Seabed surface dataset and select Set as sticky surface.
Select a line, e.g.  in your project.Sedimen Data > ATL-99-1
In the Toolbox under  right-click  and click .Commands > Schema commands Display Edit
Check the  and press .Glue to Sticky Surface Execute
Investigate the line display.
Uncheck the  and press  again and observe the difference.Glue to Sticky Surface Execute

Warning
Note that points and lines displayed onto a sticky surface are displayed without their original z-values,
and this may not be what you intend to do when displaying a foot of slope point or a bathymetric line.
Keep that in mind.
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Toolbar

Icons Description of Main Toolbar icons

Will cancel any mouse action that is started but is regretted and should be ended without any
operation.

Start a mouse action that when clicked on a graphical object will delete that object.

Start a mouse action that when clicked on a graphical object can set appearance parameters for that
object. The appearence parameters are: Opacity, Reflection, Diffusion, Ambience.

Start a mouse action where the user is supposed to click on a surface that is map with scalar values.
The mapping range of the scalar values according to the color table can then be adjusted.

Start a mouse action that when clicked on a graphical object will highlight the corresponding data
object in the project.

Start a mouse action where the user can click and draw a rectangle around displayed data and
Geocap will list all dataset names and locations.

Will delete all graphics in the current viewport or window (if the window holds only one viewport). The
corresponding references to actors in the project are deleted. Frequently used in free interactive work.

Will delete the last graphical object (also called and actor) that is displayed. Frequently used to erase
a graphical object that shall be removed. Note: Redisplaying data from the project using the same
command will erase the previous corresponding actor.

Will set the graphical window in 2D mode; i.e. only pan and zoom is allowed. The view direction (x, y
or z) depends on the corresponding setting. In 2D mode the left button on the mouse is used for
immediate cursor response for instance in digitizing.

Will set the graphical window in 3D mode; pan, zoom and 3D rolling is enabled. The default 3D
mode renders in perspective view; i.e. parallel lines are not parallel on the screen, but shows a
perspective.

Will turn the z direction of the graphical window upwards; i.e. the positive direction of the z axis points
upwards.

Will turn the z direction of the graphical window downwards; i.e. the positive direction of the z axis
points downwards. This is the default case because most surfaces are below the zero level, but still
have positive z values.

Will show the graphical window as a frame box. It is important to use this icon to check the graphical
window or whenever some display comes out weird if the display algorithm uses the graphical
window to set display parameters.

Will draw default axes for all visible axes directions. No tick marks are display for simplicity, but the
exact location of an annotation position starts at the beginning of the annotation.

Will open a Navigator which is a convenient menu for navigating a 3D graphical scene. To some
(especially newbies) it can be difficult to use the mouse buttons to orientate the graphics. Be aware
that rotation is around the focal point which also can be set by pointing the cursor mouse at a any
location on a solid object and push keyboard x.

Will zoom in towards the focal point. The graphical window is not changed, although the graphical
frame may lie out the visible part of the screen.

Will zoom out from the focal point.

Will View from above. This icon also contains sub-icons for viewing in other directions.
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If several windows are created on the same Tab, this icon connects the selected windows to the
same visual camera. Very useful when different surfaces that shall be compared are displayed in
separate windows that are connected and show the same under all graphical movements.

Will show the viewport menu that allows for a quick way to create viewports inside a window. The
number and layout of the viewports are determined by just double clicking on the lower right frame in
the veiwport menu. If the viewports are connected they can also by used for simultaneously display of
surfaces or features that shall be compared. 

Enables the light source to be moved around in the graphical scene. Will create shadows and
highlight features. Usefull for presentation graphics and detailed studies of special structures.

Will scale the graphical scene with all its actor up or down. Very important for selecting a good view.
The scaling should also preferable be set in the   so that the preferred view comesProject Settings
up when loading a project.

Will show up a 2D compass in upper right that follows the rotation of the graphical window. Another
click on the icon will remove the compass.

 

 

Exercise

Try out the different tools on the toolbar

Try out the different tools.

-
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Keyboard shortcuts

Geocap has several   or  . Go   shortcuts to bring up a list. Akeyboard shortcuts hotkeys Help > Keyboard
selection of the most important keyboard shortcuts:

Key Explanation Key Explanation

j Snap to any point on a displayed line. + Zoom in.

o Toggle color code for last used map command
on/off.

- Zoom out.

r Rescale to all graphical elements. 2 Toggle graphics to 2d mode.

s Turn graphics into surface mode. 3 Toggle graphics to 3d mode.

v Value of height/depth (z coordinate) from
graphics.

3 Toggle stereo view on/off when stereo is
activated.

w Turn graphics into wire mode. y Cursor point is set at the surface of the
graphical element.

x Setting the focal point. The graphics will rotate
around this point.

z Zoom by drawing a rubber band with left
button on the mouse.

 

 

Exercise

Try the different keyboard shortcuts

Visualize a seabed surface and test all the above mentioned keyboard shortcuts.

When using or to snap to lines or surfaces, Geocap will report what you have snapped to in the lowerj y 
left corner.
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G. Charts

Introduction

Working with large amounts of data can be cumbersome. Thus, Seafloor lets you divide your survey area into
smaller areas called charts. These charts are populated with multibeam soundings and you can then perform
operations like gridding and points classification on each chart.

The   are commands executed on folders of schema type  , located on folders of schemaChart operations Chart
type  .Charts

The   folder contains several menu items on the right click menu. The tools for charts are located in theCharts
upper part of the menu and listed in the graphic below.

The Charts folder menu  

 

In this excercise we will look at how to ,  and  charts.create display modify

Exercises

Create a single chart from the Multibeam data
Create a single chart from the XYZ data
Create sub-charts as matrix of charts
Populate charts with data
Show properties for each chart
Display chart frames
Display chart soundings
How to modify chart definitions
How to remove a chart with the Create and Modify Charts tool

-
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Create a single chart from the Multibeam data

Exercise

Create a single chart from the Multibeam data

Click the  tab in the .Chart commands Seafloor Main Menu
Click the  button.Create and Modify Chart
In the  tab, type  as .Create Single Chart MainChart Chart name
In the  tab click .Create Single Chart Scale to Survey Data
In the dialog that pops up, tick the  folder checkbox and click . The menu shouldMultibeam OK
now look similar to the one below:

Click  to create the chart and click  in the dialog that pops up.Execute OK

 

Example of chart frame types: Single Chart, Matrix of Charts and Charts along Line.

-
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Create a single chart from the XYZ data

Exercise

Create a single chart from the XYZ data

In the  type in  as .Create Single Chart XYZ_data Chart name
In the  tab click .Create Single Chart Scale to Survey Data
In the dialog that pops up, tick the  folder checkbox and click . The menu shouldXYZ data OK
now look similar to the one below:

Click  to create the chart and click  in the dialog that pops up.Execute OK

 

 

-

It is also possible to create charts by the methods:

Get coordinates from the active window (Scale to active window).
Specifying lower left and upper right coordinates.
Specifying lower left corner coordinates, width and height.
Drawing a rectangle in the graphics window (Rubberband select).
Create Matrix of Charts.
Create Charts along a line.
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Create a matrix of charts

We will now use the  as a master chart for the whole area of your multibeam survey. We are nowMainChart
going to create sub-charts from this chart.

Exercise

Create sub-charts as matrix of charts

Click the  tab.Create Matrix of Charts
Make sure that your  has been selected in the  section of the menu.MainChart Master Chart
Keep the name  with extension set to . This will give the chart name SubChart- Automatic Sub

 and so on.Chart-1
Note that the  is  has been selectedMatrix specification By number of rowscolumns and 
with number of  and , the corresponding  is  and the Columns Rows set to 2 Width 1547,50 Hei

 is ght .1337,50
hange theTo have nicer chart sizes c  to  Matrix specification By chart geometry, and set

the   to  and . Note that the number of  and  of chartsWidth 1550 Height to 1340 Rows Columns
automatically change when you change the width.will height and 
The menu should now look similar to the image below:

Click Execute
You will be asked if you want to create 4 (2x2) charts. Click Yes
Click  in the dialog that pops up.OK
Click  on the  menuOK Create and Modify Chart

You now have one  folder, one  folder and four  folders inside the MainChart XYZ_data SubChart-x 2.
 folder.Charts

-

The amount of points we work with in this section is not very huge, so for this amount of data we would
not made the matrix of charts.  when the amount of points in the projectWe will recommend this method
is several hundreds of million, also dependent on the Geocap version (32 bit or 64 bit) and the
computer's memory configuration.
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Populate charts with data

After the you have created the charts the folders will only contain a frame, thus we need to extract the multibeam
soundings and populate them into the frames.

Exercise

Populate charts with data

Click  on the  tab in the .Extract Soundings Chart commands Seafloor Main Menu
In  type in  m to avoid any loss of data between the charts. (Dependent on theMargins 5
gridding increments.)
Tick both the  checkbox and the  Multibeam XYZ data checkbox.
Select all the  in the  section. Also select the  chart.SubChart-x Chart Name XYZ_data

Click  and the extraction process will start.Execute
Click  in the dialog the pops up.OK
Click  on the  menu.OK Extract Soundings

Each sub-chart will now contain a dataset named  in addition to the  dataset.Soundings Frame

-
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Chart properties

Exercise

Show properties for each chart

Click  on the  tab in the .Show Chart Properties Chart commands Seafloor Main Menu

Observe that the list contains one row for each chart. Take a closer look at the different columns.

Showing Chart Properties

 

Display chart data

Exercise

Display chart frames

Click  on the  tab in the .Display Chart Data Chart commands Seafloor Main Menu
Make sure that only  is checked in .Frame Select Data Object
Select all the SubCharts-x.
Make sure that  is checked.Scale to selected charts
Click .Execute
Check the  box to see the name of the charts.Chart Name

 

 

Exercise

Display chart soundings

Open the  menu again.Display Chart Data
Check the following boxes; , , ,  aFrame Soundings Use colour range Use same range for all
nd .Use LOD
Select all the SubCharts-x.
Click .Execute

 

-
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Modify chart

The Modify Chart tab can be used to rename the chart or change the definitions of the chart frame.

Exercise

How to modify chart definitions

Click the  tab in the .Chart commands Seafloor Main Menu
Click the  button.Create and Modify Chart
Open the  tab and look at the content.Modify Chart
Click the  button and select the  chart.Chart to modify XYZ_data

In the  part, change the  from 5910 to  (meters).Chart Frame Height 5900
Click .Execute
Click  on  and  Yes  Do you really want to modify chart "XYZ_data"? OK in the information
box which appears next.
Click the  button up to the right for all the tabs to verify the changes.Show Chart Properties

 

 

-

When the chart frame is changed it can be necessary to repeat the  operation. In theExtract Soundings
example above the change is so small that we do not want perform a new extraction of points. We have
also made the area smaller so we will not need to get more points for filling into the chart frame.

If we had been through the gridding of the chart we should consider to redo the gridding operation within
the new chart frame.
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Manipulate charts in the Miscellaneous tab

In the Miscellaneous tab there are som additional tools for the charts:

Rename charts: Will rename the selected charts (chart series) to new charts series name and number.
Export chart definitions: The chart names and chart extensions (frame) can be exported to an ascii file.
Import chart definitions: The chart names and chart extensions can be imported from an ascii file.
Delete charts: The selected chart(s) will be removed from the project.

Exercise

How to remove a chart with the Create and Modify Charts tool

Click the  tab in the .Chart commands Seafloor Main Menu
Click the  button.Create and Modify Chart
Open the  tab and look at the content.Miscellaneous
In the  part, select the  option.Mode Delete charts
In the  list, select the  chart:Chart Name XYZ_data

Click .Execute
Click  on  and  in the information box which appearsYes  Do you want to delete 1 chart? OK
next.
Notice that the Chart Name list is updated and the XYZ_data chart has disappeared.

 

 

The command  have some other options for the charts. The command can removeRemove Chart Data
specific chart items like Boundary, Holes, Seafloor, Soundings etc.

The command can also remove  charts, i.e. charts which are missing  after Empty Soundings Extract
Soundings.

The command can also remove the entire chart(s), like the  option described in theDelete charts
exercise above.

It is also possible to remove charts simply by deleting the chart's folder from the  main folder.2. Charts
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H. Gridding Files and Charts

Introduction

Gridding can be performed directly on processed multibeam data or on separate charts. Seafloor offers several
gridding algorithms, filtering and smoothing. Filtered points can be saved in the project.

Exercises

Gridding multibeam data
Displaying the result grid
Gridding charts
Display Chart grids
Display rejected soundings
Merge Chart surfaces

-
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Gridding Multibeam Data

Exercise

Gridding multibeam data

Right click the  folder under , select  anMultibeam 1.Survey Data Gridding Multibeam Data...
d the gridding menu will pop up.

Multibeam gridding menu
Keep  as the gridding algorithm.Weighted Average
Change  to  and keep the  option.X increment 2.5 Use YInc=XInc
In the  tab set  to  and verify that the  is set to Algorithm Parameters Search radius 5 Unit Grid

.node(s)
Keep the  as .Weight function 1/D
Select all the survey lines (click one and use ctrl + a).
Click  and the gridding process will start.Execute
When the gridding has finished a report window will pop up, showing the details of the gridding
process
Click .OK

The grid is saved as  in the  folder.Surface_WeightedAverage 1. Survey Data / Multibeam

Exercise

Displaying the result grid

Right-click the  grid in the  folder andSurface_WeightedAverage 1. Survey Data / Multibeam
select .Zoom to Data
Right-click the  grid again and select .Surface_WeightedAverage LOD Grid Display

-
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Gridding data in Charts

Exercise

Gridding charts

Select the  tab in the .Chart commands Seafloor Main Menu
Click .Gridding Chart
Keep  as the gridding algorithm.Weighted Average
Change  to  and keep the  option.X increment 2.5 Use YInc=XInc
In the  tab set  to  and Algorithm Parameters Search radius 5 verify that the Unit is set to Grid
node(s).
Keep the  as .Weight function 1/D
Check the  box.Filter input points
Click the  tab.Filter and re-grid
Check the  box, set  to  and set Save filtered points Filter type Standard deviation Shallow

 and  to .factor Deep factor 3
Select all the  (click first and use shift + click on last).SubChart-x
Click  and the gridding process will start.Execute

When the gridding has finished, each sub chart folder will have three new datasets: , Seafloor Sound
 and .ings_Accepted Soundings_Rejected

 

 

Exercise

Display Chart grids

In the  tab in the , click .Chart commands Seafloor Main Menu Display Chart Data
Make sure  box is checked.Frame
Check the  box and make sure  and  is checked.Seafloor Use same range for all Use LOD
Make sure the  is checked.Scale to selected charts
Select all the  (click first and use shift + click on last).SubChart-x
Click .Execute

 

 

Exercise

Display rejected soundings

Click the  icon on the main toolbar to remove all graphics.X
Go to the folder  in the project.SubChart-1
Right click the  dataset and select .Seafloor Zoom to Data
Right click the  dataset again and select .Seafloor LOD Grid Display
Right click  and select .Sounding_Rejected LOD Points Display

You will now see the points that were filtered away with the standard deviation filter during the
gridding process.
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Exercise

Merge Chart surfaces

Right-click the  folder and select .2. Charts Merge Surfaces
Click the browse button and select the  folder to save the merged2. Charts / MainChart
surface in.
Keep the default option for  (Use increments from first grid).Specify surface increments
Select all the subcharts and move them over to the right column by clicing the  button. The>>
menu should now look like the image below:

Click  and a dialog will pop up asking if you want to merge 4 charts.Execute
Click .Yes

A report window will pop up when the merging has been performed. The merged surface will be
saved in the  folder.2. Charts / MainChart
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I. Multibeam Depth Editing

Introduction

Seafloor enables you to perform both   and  of sonar data.automatic depth filtering manual editing

The  offers three filters:automatic depth filtering

A threshold filter which will remove all points shallower or deeper than the threshold.
An angle filter which measure the angle between neighbour points on the same ping and eliminate those
exceeding a certain value.
A surface filter which can calculate the standard deviation for all points and remove points outside, e.g. 2
times the standard deviation.

The  is performed by the  (Multibeam Editor).manual editing Point Cloud Editor

 

Exercises

Automatic Threshold filtering
View the result from the automatic Threshold filtering
Automatic Surface filtering
View the result from the automatic Surface filtering
Revert flagged points from automatic filtering
Manually edit a single multibeam survey line
Display removed points and undelete them again
Manually edit multiple multibeam survey lines

 

  

Automatic Filtering

Exercise

Automatic Threshold filtering

Right click the  folder inside  and select Multibeam 1. Survey Data Multibeam Depth Filtering
.
In the menu that pops up, check the  box.Treshold filter
To find the min and max, click the  button.Show Survey line properties...
Check both  and  and type in theRemove shallower than depth Remove deeper than depth
min and max value.
Leave the  box unchecked for now.Angle filter
Leave the  box unchecked for now.Surface filter
Select one or several of the survey lines.
Click .Execute

In the report that appears you can see how many points that were flagged in each multibeam file.

Note that none of the methods will actually delete the points. They will only be flagged as deleted, which
means you can go back to the original, unfiltered version at a later stage.

The editing methods described in this section are also applicable on Point Cloud (XYZ) data.



Page 46

1.  
2.  
3.  

4.  

5.  
6.  

7.  
8.  

9.  
10.  

Exercise

View the result from the automatic Threshold filtering

Open the  dialog.Display Multibeam Data
Display (some of) the lines which have been filtered.
Click the  button in the lower part of the window.Open Point Flag Visibility Filter

The  dialog is opened.Point Flag Visibility Filter

Click the  button on the menu bar.Add
The dialog for adding filter is opened.

Select, for instance, the  entry and click .ThresholdShallowerFiltered OK
Repeat clicking the  button. This time, select the  entry andAdd ThresholdDeeperFiltered
click .OK
In the  dialog, tick the  checkbox for both filters.Point Flag Visibility Filter Color
Click the  button and set individual colors for the filters.Edit Color

The Threshold filtered points are now displayed together with the accepted points.
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Exercise

Automatic Surface filtering

Right-click the  folder inside  and select Multibeam 1. Survey Data Multibeam Depth Filtering
.
In the menu that pops up, check the  box.Surface filter
Click the browse icon and browse in the surface you generated in the Gridding chapter.
Select  as .Standard Deviation Filter type
Select a  and a .Shallow factor Deep factor
Select one or several of the survey lines.
Click .Execute

 

 

Exercise

View the result from the automatic Surface filtering

To view the result from the automatic Surface filtering, the method is the same as for Threshold
filtering.

Open the  dialog.Display Multibeam Data
Display (some of) the lines which have been filtered.
Click the  button in the lower part of the window.Open Point Flag Visibility Filter
Click the  button on the  dialog menu bar, and select the Add Point Flag Visibility Filter Surfa

.ceFiltered
In the  dialog, tick the  checkbox for  (andPoint Flag Visibility Filter Hilight SurfaceFiltered
also tick  for the threshold filters).Hide

The points that are displayed are the ones that got flagged by the surface filter.

 

 

Exercise

Revert flagged points from automatic filtering

Right click the  folder in your project and select .Multibeam Revert flagged points
Check the flags you want to revert.
Select the  you want to revert from.Survey Lines
Click .Execute
Click  when asked about reverting flags for 6 files.Yes

After the processed has finished you are presented with a report telling you how many points were
reverted for each flag for each survey line.

-

To remove the accepted points, tick the  checkbox for .Hide All Points
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Manual Editing

The  lets you manually edit points in both 3D and 2D. Removed points will be flagged asPoint Cloud Editor
deleted, but can later be retrieved.

The Point Cloud Editor menu

The menu has two parts. A  part and an  part.Selection Action

Selection
You have to select a set of points before you can perform an action on them. There are five different ways to
select points:

Rubber band select (shortcut key ) - Click and drag a rectangleR
Lasso select (shortcut key ) - Digitize a polygon (double click to close)L
Threshold select - Select a  or  value.Deeper Shallower
Expand selection to ping - First use one of the other tools to select points. Then click the this tool to select
all the other points in the corresponding ping(s).
Flag select - Select by flag type

After selection the points will be visualized in white.

Action
After a set of points have been selected it is possible to perform several actions on them:

Delete them (shortcut key ) - The points are only flagged as deleted.Delete
Un-delete them.
Flag them according to a user defined flag.
Edit on the selected points.

By clicking  it is possible to make a new selection only within the previous selection. This makes itEdit Selected
easier to narrow in on points/noise you want to delete.

The green arrows allows you to redo or undo previous step, while  will allow you to make all the pointsEdit All
available for editing.

Note that by clicking  ( ) or  ( ) the 3D window will be locked untilRubber band select R Lasso select L
you have finished the selection. This means that you will not be able to rotate or pan during the selection
process.

It is possible to deselect parts of a selection by changing the drop down list to  Remove from selection
and then perform another selection within the previously selected points.
You can also use the  icon to remove the selection.Clear selection
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Exercise

Manually edit a single multibeam survey line

In the  folder, right click on of the Multibeam Survey datasets and select Multibeam LOD
.Points Display

Click on the small triangle next to the Multibeam Survey dataset to expand all its elements.
Right click  under the Multibeam Survey dataset and select .Multibeam Sonar Edit
Click the  icon.Rubberband Select
In the graphics window, click and drag the rubber band around an area where there are spikes
you want to remove.
Notice that the selected points are displayed in white.
Click  and notice that the points are removed.Delete
Continue to select and flag points until you have removed all the spikes.
Click .OK

 

 

Exercise

Display removed points and undelete them again

On the  tab in the  click .Multibeam Sonar Seafloor Main Menu Display Multibeam Data
Click .Open Point Flag Visibility Filter
Click .Add
Select  and click .UserDeleted OK
Tick the  box for the  flag and observe that the points you deleted areHighlight UserDeleted
now displayed in red.
Open the  again.Multibeam Editor
Press  on your keyboard and draw a rectangle around all (or some) of the red points that youR
want to undelete.
Click  and observe that the points are now display normal again.Undelete

 

 

Exercise

Manually edit multiple multibeam survey lines

Click the  on the main toolbar to clear the screen.X
On the  tab in the  click .Multibeam Sonar Seafloor Main Menu Display Multibeam Data
Select all survey lines and click Execute
On the  click  and select .Seafloor Main Menu Edit Multibeam Editor
Click on  and create a large selection area around some spikes you wantRubberband Select
to remove.
Click . Notice how all points outside the selection are are now transparent whileEdit Selected
the selection area is displayed in "normal" colors again.
Click  and make sure to select an area containing both transparent and "normal"Lasso Select
points. Notice that only the "normal" points are selected.
Repeat the last two steps until you have narrowed into the spikes you want to remove.
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J. Navigation Processing and Editing

Introduction

Seafloor enables you to perform both automatic processing and manual editing of navigation data. The
automatic navigation processing offers two methods:

A spike filter which will remove points which seems to have a speed faster than a certain value.
Moving average filter which smooths data according to a given "point window" length.

Manual editing is possible by using the  menu, which is a general menu who combines data tables,Table View
2D view and 3D view.

Exercises

Automatic navigation processing
Manual editing of navigation data

 

The delete methods will actually remove the points from the navigation line, while the smoothing
operation will save the original positions, which means that you can return to the unsmoothed version at
a later stage.
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Exercise

Automatic navigation processing

Right click the  folder inside  and select .Multibeam 1. Survey Data Navigation Processing

In the Navigation Processing dialog check the  boxSmooth
Set Window length to , and iterations to .5 1
Check that the smoothing mode is .Apply
Select one or several of the survey lines.
Click Execute
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Exercise

Manual editing of navigation data

In the project click on the small triangle next to a Multibeam Survey dataset to expand all its
elements.
Right click  under the Multibeam Survey dataset and select .Navigation Table View
Right click the  data object and select .Navigation Display
In the  table view menu, click the  button.Navigation 2D Plot>>
Check the  box.Display marked points
Expand the window to better see the table and the graphics.
Check the data columns in the data set.

In the graphics window, hold the  button and click and drag the rubber band around theShift
points you want to investigate.
Notice that the selected points are displayed both in the table and in the 3D graphics window.
Use the buttons  and  toRubber band mark (3D window) Rubber band unmark (3D window)
select and de-select points.
To enable for deleting points you must click the  button.Edit Mode
Click  to close the menu.Close
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K. The Cross Section Window

Introduction

Geocap Seafloor can compare data from different datasets by viewing the data in a cross section view. By
changing the visualisation attributes it is possible to identify problems in the data. In this exercise the data will be
visualised in both 3D and 2D.

 

 

Exercises

Compare two overlapping survey lines against each other
Edit the color and size of points in the cross section window
Edit the size, direction and position of the profile

 

Exercise

Compare two overlapping survey lines against each other

Make sure you have displayed two overlapping survey lines in the graphics window, using the same
method as in one of the previous exercises. For instance, display the two lines 0000_20060112_1301

 and .56_Simrad_echo.all 0001_20060112_131814_Simrad_echo.all

In the Geocap main window, click  . The crossWindows > New > Cross Section Window
section window will appear at the bottom of the screen.

In the cross section window click the arrow to right of the

icon, and open the menu.
Click the

 entry in menu.Digitize cross section
Create a profile over the overlapping area, by digitizing two points in the graphics window
using your left mouse button.

You should now see the multibeam soundings along the profile in the cross section window. You can
zoom using your right mouse button, use the left mouse button to pan and the mouse wheel to scale
the z-direction.

 

 

The Cross Section Window can be used to check calibration of the multibeam survey lines.

Points at a certain distance on both sides of the cross section are projected on to the cross section
window. You can decide this distance by editing the .Point projection distance
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Exercise

Edit the color and size of points in the cross section window

In the cross section window, right click one the name of one of the survey line and select .Edit

In the dialog that pops up, change the  to another color than the default.Point color

You should now be able to distinguish the points on each line from each other.

Try out different display options in the  dialog.edit

Exercise

Edit the size, direction and position of the profile

In the graphics window click on the profile frame. You should now see one sphere in each
corner of the profile.

Click and drag one of the spheres to re-size or change the angle of the profile.
Click in the middle of the profile and drag in order to move the whole profile.
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L. Vessel Configuration Manager

Introduction

Multibeam data are imported by the command . As a part of the import the makeImport Multibeam Sonar Data
and vendor of the multibeam echosounder is registered. Vital information like the mount parametres are read
from the datafiles and will be saved in a Vessel configuration file in the project. Multibeam files with different
installation parameters will have reference to different vessel configuration setup.

Exercises

Open the Vessel Configuration Manager
Check all parameters
Change Roll parameters

 

Exercise

Open the Vessel Configuration Manager

In the , go to Seafloor Main Window Edit > Vessel Configuration Manager...

Right click one of the  and select .Vessel configurations Edit
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Exercise

Check all parameters

Click the  tab to see the information.Mount parameters
Click the  tab to see the information.Processing parameters
Click the  tab to see the information.Standard deviation parameters

 

 

Exercise

Change Roll parameters

Click the  tab.Mount parameters
See the Roll angle value, .-0.640
Change the value to .-2.640
Click .OK
Also click  in the Vessel Configuration Manager dialog.OK
Redisplay the survey lines  and 0000_20060112_130156_Simrad_echo.all 0001_20060112_13

.1814_Simrad_echo.all
Verify the changes in the roll.
Again, open the Vessel Configuration Manager dialog.
Click the  tab.Mount parameters
Click the  button and verify that the Roll angle is reset back to .Use file values -0.640
Click .OK
Also click  in the Vessel Configuration Manager dialog.OK
Redisplay the survey lines  and 0000_20060112_130156_Simrad_echo.all 0001_20060112_13

.1814_Simrad_echo.all
Also try the Roll angle .-0.300
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M. Import Sensor data

Introduction

Seafloor can import and replace the sensor data of the selected multibeam survey lines from ASCII formats. 
Sensor types which can be import replaced:

Navigation
Tide
Velocity
Heave
Roll
Pitch

Exercises

Check available ASCII formats
Create new project
Load multibeam sensor data
Import Tide file
Import Navigation file

 

Exercise

Check available ASCII formats

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...
Click the  icon and open the help menu.?
Check the available .Sensor type
Click .OK

 

Preparations

Before we can load the ASCII sensor data we need to have a project with multibeam data.

Exercise

Create new project

In the main menu of Geocap, click .Seafloor > Seafloor Main Menu
In the Seafloor Main Menu click . A new dialog will pop up.File > New > Project
Select the  project template.Seafloor
Type the project name  into the  field. EM2040_WGS84_UTM_60S Name
Click the  button, and select where you want to store your project on your hard disk.Browse
Click .Finish
You are now be prompted with a window asking you if you want to define the geodetic setting
of the project.
Click .Yes
Check the  box and select  as datum and Use geodetic settings for project WGS84 UTM

 as coordinate system.Zone 60 S
Click .OK
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Exercise

Load multibeam sensor data

Click the  tab in the .Multibeam Sonar Seafloor Main Menu
Click .Import Multibeam Sonar Data
Click the browse icon and browse to the folder ...\Seafloor_Course\Multibeam Sensor

.Data\EM_2040\South_seas_wreck_closeup
Select all 13 files and click .Open
Keep the  as is.Import Options
Click  and the import will start.Execute
After import a dialog will pop up, with information about the import. This report will also be
available in the folder .1. Survey Data / Multibeam /Reports
Display the multibeam survey lines by the command .Display Multibeam Data

 

Import Tide file

Exercise

Import Tide file

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...
Click the browse icon and browse for the file  inpredictedtide.tide  the folder ...\Seafloor_Cou
rse\Multibeam Sensor Data\EM_2040\tide.
Make sure that  is selected in under . Let the option  beTide Sensor type Reverse sign
un-checked.
Select all the Survey lines.
Click .Execute
Re-display by the command Display Multibeam Data. Do you see any differences?
Import the tide file predictedtide.tide once more on all the files. This time set the option Revers

 checked.e sign
Re-display by the command . Do you see any differences?Display Multibeam Data

 

Import Navigation file

Exercise

Import Navigation file

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...
Click the browse icon and browse for the navigation file merged_navigation_south_seas_wr
eck_closeup.txt in the folder ...\Seafloor_Course\Multibeam Sensor

.Data\EM_2040\navigation
Make sure that  is selected in under .Navigation Sensor type
Select all the Survey lines.
Click .Execute
Re-display by the command . Do you see any differences?Display Multibeam Data
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N. Export Multibeam Data

Introduction

Seafloor lets you export multibeam survey data as Points and Navigation.

There is a wide range of export possibilities and formats such as, VTK, Esri Shapefile, ASCII Column, VTK
ASCII and Dxf ASCII.

Exercises

Export Multibeam Points
Export Navigation data

 

Export Multibeam Points

Exercise

Export Multibeam Points

Right click the  folder under  and select Export Multibeam 1. Survey Data Export Multibeam
Data Sensor...
Click the  icon and read the help text.?
Click the tab. Export Points
Select the two first survey lines in the  part.Survey Line
In the  part, select the  format. Export Format ASCII Column
Click the  button to open the format selection dialog. Click the columnAscii export settings
datatypes ( ,  and ) too see the choices. Then close the dialog with .X Y Z Cancel
In the  part select the folder name for the output.Output file
Click .Execute
Check the result in the selected output folder.

 

Export Navigation data

Exercise

Export Navigation data

Click the tab. Export Navigation
Select the two first survey lines in the  part.Survey Line
In the  part, select the  format. Export Format ASCII Column
Click the  button to open the format selection dialog. Note the columnAscii export settings
datatypes , ,  and . Close the dialog with .DateTime X Y Z Cancel
In the  part select the folder name for the output.Output file
Click .Execute
Check the result in the selected output folder.
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O. Chart Utilities

Introduction

In Seafloor there is a lot of functionality to create more results and analysis. Some of the functionality mentioned
in this section is started from the , or from the  folder, or from a specific data type,Seafloor Main Menu Charts
like .Structured Points

 

Exercises

Make Outline and Holes
Quick digitizing
Make Profile

 

Make Outline and Holes

This command will create outline polygons (boundary ) and/or interior holes from either points or surfaces in the
selected chart(s). The command has options to make the polygons from  or  data objects inSoundings  Seafloor 
the charts.

Exercise

Make Outline and Holes

In the  tab in the , click .Utilities (2) Seafloor Main Menu Make Outline and Holes
Inside the frame named "Make polygons from", click the option .Seafloor
Check the box ahead of , and use the option .Outline  Keep all outline polygons
Check the box ahead of , and use the option .Holes  Keep all holes polygons
In the Chart Name part, select the MainChart (or another chart).
Click .Execute
Verify the new data sets  and  in the chart folder.Boundary Holes

 

Repeat the exercise by trying the option   and turning  the option to make theRemove small outline poygons off
Holes polygons.

Also make the outline from the  dataset.Soundings

 

-

The command can also be executed from any folder of type , ,  or Generic Soundings Single Beam Mult
. Select either  or  to make polygons from. The command will not merge the inputibeam Points Surface

data but process each input dataset individually.

The command can also be executed from any  or  dataset.Structured Points Poly Data/Pointcloud



Page 61

1.  

2.  
3.  

4.  
5.  

6.  
7.  
8.  

Digitizing

Digitizing is one of the most important ways the user can interact with Geocap to create new dataset. In contrast
to typing in numbers in an editor, the digitizer gives the user the ability to interact with graphically displayed data.

Exercise

Quick digitizing

Make sure you have displayed all relevant data before you start the digitizing. Also check if the
graphics window is in  mode.2D
The  is started from .Quick digitizer Tools > Quick Digitizing
Check the box ahead of  in the lower part of the menu. The rubber line can beUse rubber line
turned on and off during the digitizing by pressing the  key on the keyboard.b
Click   and use the left mouse button to digitize.Start digitizing
Click   if you want to close the polygon, or Connect to start press the h key (=home) on the
keyboard.
To start a new line segment, press the  key (=insert flag) on the keyboard.f
Click   to save the line/polygon.Stop digitizing
The digitized_line is now in the workspace. To save the data set in the project, select a folder
and right click and select .New > Workspace Data > digitized_line

-

A digitized line is saved in the workspace by default. Use the Save digitized line also in
 option to save it directly in the project. Just tick the check box and browse in the folderfolder

you would like to save it to.
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Make Profile

This command will extract continuous profile data based on a line crossing the selected chart(s). The command
has two options, make one   or multiple  . The profiles will be seamless over theAlong profile Across profiles
edges of the input charts.

Exercise

Make Profile

First use the  to create a profile line over the actual surface(s). It is alsoQuick Digitizer
possible to import an existing line from a disk file.
In the  tab in the , click .Utilities (2) Seafloor Main Menu Make Profile
In the project folder, locate the profile line (for example ). Then, in the Profile Datadigitized_line
part, click the green arrow to the left of the text field to select the line.
Select the Mode . and set the parameters  to  and Along Profile Point spacing (m) 1,00 Start

 to .value (m) 0,00
Select all the sub-charts. in the Chart Name part.
Click Execute
This will create the dataset  in the same folder as the XY profile isdigitized_line_alongProfile
located.
Change the mode to Across Profiles. Set the parameters  to ,Profile spacing (m) 10,00  Profil

 e length (m) to 50,00, Point spacing (m) to 1,00, and Start value (m) to 0,00.
When clicking  the dataset .Execute digitized_line_acrossProfile
Display both lines in the 3D window.
Also open the Table View for each of the new datasets to look at the data.

 

Along and Across profiles shown on the surface.
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P. Points Classification

Introduction

Seafloor can automatically classify points into the following categories:

Shoals
Deeps
Ridges
Saddles
Valleys

The user can specify the search radius and angle, where applicable. The points will be saved as separate
datasets in a  folder under each chart.classification

Exercises

Classify points
Display classified points

 

Exercise

Classify points

On the  tab in the , click .Utilities (2) Seafloor Main Menu Point Classification

Check the box for  and the box for .Shoals Deeps
Note all the boxes for the different classification types.
Specify the search radius, for instance , in the corresponding tabs for the two data types.50
Select the main chart.
Click .Execute

The resulting datasets can be found in the  folder under the chart.classification

This exercise expects that the project already contains at least one chart and a corresponding  Seafloor
surface.
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Exercise

Display classified points

Browse to the  folder for the actual chart.classification
Display the dataset  by right click and select .shoals_50 Display Points
Display the dataset  by right click and select .deeps_50 Display Points

 

Repeat the last excercise by changing the search radius. Also try to check the box Find corresponding points
.in Soundings
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Q. Statistical Point Reduction

Introduction

This command will reduce the amount of points from one or more input data sets. The selection method can for
instance be priority of the  or  depth values. The selection area can be by looking at pointsMinimum  Maximum 
inside a  or  . The selected points are always with the original position and not snapped into anyRectangle  Circle
grid structure. 

The output will be a new point data set which in Geocap will have a schema of type  . The commandPointcloud
is a folder command and is implemented for folders with schema types  ,  ,  and Charts Multibeam Soundings  Ge

.neric

Seafloor can select the points within the following categories:

Minimum
Maximum
Shallower than Mean
Deeper than Mean
Closest to Mean

Selection of shallowest point within 250 m radii.

Exercises

Select points within Circle
Display selected points

 

This exercise expects that the project already contains at least one chart and a corresponding  Seafloor
surface.
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Exercise

Select points within Circle

On the  tab in the , click .Utilities (2) Seafloor Main Menu Statistical Point Reduction

Check the selection area .Circle
Set radius  meters.25
Check the Point selection methods  and .Minimum Maximum
Note that the uncheckable boxes are for the Rectangle selection area.
Select the main chart.
Click .Execute

The resulting datasets can be found in the specified chart folder a with the name Soundings_<meth
.od>_Radius_<radius>

Exercise

Display selected points

Browse to the folder for the actual chart.
Display the dataset  by right click and select Soundings_Minimum_Values_Radius_25 LOD

.Points Display
Display the dataset  by right click and select Soundings_Maximum_Values_Radius_25 LOD

.Points Display

 

Repeat the last excercise by changing the radius. Also try to run the command with the selection area Rectangl
.e
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R. Surface Volumetrics

Introduction

In Seafloor there is a lot of functionality to create more results and analysis. Some of the functionality mentioned
in this section is started from the  , or from the   folder, or from a specific data type,Seafloor Main Menu Charts
like  .Structured Points

Exercises

Surface Volumetrics

Surface Volumetrics

The command   calculates the cut and fill volumes between two surfaces or betweenSurface cut/fill volumetrics
a surface and a polygon data set representing the theoretical terrain.
The cut volume can be seen as the volume to be dredged (positive volume), whereas the fill volume is the
volume to be filled (negative volume).

The command reports the volume and the area (horizontal projection) of the cut and fill volume in a text item.

In addition this command can produce the following products:

Cut surface
Difference surface
Terrain with cut
Terrain with fill
Terrain with cut and fill
Cut area
Fill area

Exercise

Surface Volumetrics

First use the  to create a closed polygon where the volume is to be calculated.Quick Digitizer
It is also possible to import the polygon from a disk file. Use the underwater shoal in the
MainChart as the feature to volume calculate.
Create the polygon in the MainChart folder by .New > Workspace Data > digitized_line
Rename the polygon to the name .digitized_closed_polygon
It is possible to diqitize the polygon with a depth value, but the depth value can also be
assigned by the  command. From the item  selPolydata Function digitized_closed_polygon,
ect  . SetAll Commands > Shared Commands > Operations > Polydata Function...
function  and click Execute.z = 60
Rename the new polygon to .digitized_closed_polygon (60m)
From the  icon in the MainChart folder, click .Seafloor Surface cut/fill volumetrics
In the  dialog, insert the  intoSurface cut/fill volumetrics digitized_closed_polygon (60m)
the Cut surface/polygon input field. (Mark in the project and then use the green arrow to the
right.)
Turn on the options ,  and Create cut surface Create terrain with cut Create terrain with cut

.and fill
Click .Execute
The results from the volume calculation is presented in the Report menu. In the MainChart
folder a new folder  is created containing the produced data sets, , Volumetrics CutSurface Te

 and .rrainwithCut TerrainWithCutAndFill
Display the datasets and the polygon to see the difference.
Change the depth level for the polygon  as in the steps  and , and repeat the steps to 70, 3 4 6

.to 10
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The actual surface and the digitized closed polygon.

 

The cut surface and the digitized closed polygon at level 60 m.

The terrain with cut and fill and the closed polygon.
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S. Export Data from Charts

Introduction

Seafloor lets you export Polygons, Points, Surfaces, Hill shades, Contours.

There is a wide range of export possibilities and formats such as, Shapefiles, ASCII-formats, GeoTiff,
Irap-formats and VTK.

Exercises

Export surfaces as Irap ASCII
Export surfaces as points
Try different export formats for surface export
Export all soundings
Export contour lines to ASCII
Export contour lines to KML
Export contour areas
Export Hill Shade as GeoTiff

 

Surfaces

Exercise

Export surfaces as Irap ASCII

In the  tab in the , click .Utilities Seafloor Main Menu Export Chart Data
Click the  tab.Surfaces
Select all the sub-charts.
Select  as the .Irap ASCII Export Format
Click the browse icon and select a directory to save the files.
Leave the  blank. This will cause your files to be named  File name "Seafloor_SubChart-1.ifgr"
and so on.
Click .Execute

Exercise

Export surfaces as points

In the  tab in the , click .Utilities Seafloor Main Menu Export Chart Data
Click the  tab.Points
Check the  box.Seafloor surfaces as points
Select all the sub-charts.
Select  as the .ASCII Column Export Format
Click the browse icon and select a directory to save the files.
Leave the  blank. This will cause your files to be named  File name "Seafloor_SubChart-1.asc"
and so on.
Click .Execute

Exercise

Try different export formats for surface export

Repeat the previous exercise, but this time use  and/or  as export format.KML Shape
Try opening the files in another software that can read these files e.g. Google Earth, ArcGIS,
QGIS etc.

Note that Google Earth will have problem loading files with large amounts of points. You should try to
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Soundings

Exercise

Export all soundings

In the  tab in the , click .Utilities Seafloor Main Menu Export Chart Data
Click the  tab.Points
Check the boxes for ,  and Soundings Soundings_Accepted Soundings_Rejected.
Select all the sub-charts.
Select  as the .ASCII Column Export Format
Click the browse icon and select a directory to save the files.
Leave the  blank.File name
Click .Execute

This will export three datasets for each sub chart.

Contours

Exercise

Export contour lines to ASCII

On the  tab in the , click .Utilities Seafloor Main Menu Export Contours
Check that the  radio button is ticked.Export as: Contour Lines
Select the .Master Chart
Set  to .Contouring method Incerement
Set  to .Increment (m) 1.00
Also consider the parameters , , and Use min level Use max level Invert Z
Check the  option .Save to File and project
Select  as .ASCII Column Export Format
Click the browse icon and select a directory to save the files.
Enter  as a prefix for for the file names.1m
Click .Execute
Verify that the files are saved on the prefered folder on the disk.
Verify that the selected chart now have a  dataset saved in the charts' folder.Contours

Exercise

Export contour lines to KML

Repeat the exercise above, but this time select  as the export format.KML
Try to open the exported file in Google Earth

limit the amount of points to less than 50 000. Right-click a grid and select  to see theProperties
amounts of points in a grid.
To reduce the amount of points you need to create grids with coarser resolution or create smaller sub
charts.

Geocap exports KML-files with default settings (yellow pin for points). If you want to change the visual
settings for the KML file, you can use text editors like Emacs or Notepad ++. Read more about .KML

https://developers.google.com/kml/documentation/kml_tut
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Exercise

Export contour areas

On the  tab in the , click .Utilities Seafloor Main Menu Export Contours
Check that the  radio button is ticked.Export as: Contour Areas
Select the .Master Chart
Set  to .Contouring method Incerement
Set  to .Increment (m) 5.00
Check the  option .Save to File only
Select  as the .Shape Export Format
Click the browse icon and select a directory to save the files.
Enter  as a prefix for for the file names.5m
Click .Execute
Verify that the files are saved on the prefered folder on the disk.

Hillshade

Exercise

Export Hill Shade as GeoTiff

On the  tab in the , click .Utilities Seafloor Main Menu Export Chart Data
Click the  tab.Hill Shade
Set  to .Altitude deg: 45
Set  to .Azimuth deg: SouthWest
Set  to .Z Scale: 10
Select the .Master Chart
Check the  option .Save to File and project
Select  as the .GeoTiff Export Format
Click the  icon and select a directory to save the files.browse
Enter  as a prefix for for the file name.45deg_SoutWest_Zx10
Click .Execute
Verify that the file is saved on the prefered folder on the disk.
Right-click the  dataset in the  folder and select .HillShade Master Chart Display
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T. Image Georeferencing

Introduction

This tutorial will guide you through the process of georeferencing a map. To georeference a map or image you
need at least 3 tie points. These points should cover as much of the map as possible. In this tutorial we will use
a sea chart from the Oslofjord. This chart has some marked positions referenced in WGS84, UTM Zone 33, as
tie points.

Exercises

Import an image into your project
Georeference an image
Convert an image to another UTM zone

 

Exercise

Import an image into your project

Create a  folder (i.e. a folder with schema Generic) and rename that folder to Generic My
.Maps

Right-click the  folder and go to . Browse for the image My Maps Import > Generic sjokart.pn
 (a *.jpg or a *.png).g

Make sure the schema of the image set to .Image Data

A map about to be georeferenced.

It is important to understand what coordinate system and datum the map is in - or make a qualified guess. Note
also that you should be able to determine the coordinates of your tie-points, here encircled in red.
The tie-points can be find in the text file coordinates.txt:
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Coordinate system: WGS84, UTM zone 33
Lower left: East: 241073.89 North: 6599354.87
Upper left: East: 240904.64 North: 6601351.49
Upper right: East: 245955.69 North: 6601663.55

 

 

Exercise

Georeference an image

Use the Georeferencing wizard to georeference an image. Follow the step-by-step procedure below.

Georeferencing step by step

Make sure the image is selected in the project and right-click and select the  command inGeo Reference
the pop-up.
(If it is not visible you will have to open the  by ).Toolbox View > Toolbox

Then the dialog for setting the coordinate system and a window containing the image is shown:

Set geodetic properties of the chart: .WGS84, UTM Zone 33 N

Click .Next

Set  to .Method: Scale and Translate

Set  to XY.Tie point Coordinate Format:

Type in the  =  and  =  for the first tie point, click  and click on theX 241073.89 Y 6599354.87 Image pick
corresponding point in the map.
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Change to .Tie point 2

Type in the  =  and  =  for the second tie point, click  and click on theX 240904.64 Y 6601351.49 Image pick
corresponding point in the map.

Change to .Tie point 3

Type in the  =  and  =  for the third tie point, click  and click on theX 245955.69 Y 6601663.55 Image pick
corresponding point in the map.
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Evaluate the result. The  represents the accuracy of the georeferencing. The value should notPixel error
exceed more than 1 pixel on each point.

Click Finish. 

Now the image must be transformed from  to .UTM Zone 33 UTM Zone 32
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Exercise

Convert an image to another UTM zone

From the image sjokart, right-click and in the pop-up select All Commands > Shared
Commands > Operations > Convert to UTM. (If it is not visible you will have to open
the Toolbox.)

Set the new geodetic properties for the image: WGS84, UTM Zone 32 N.

Specify how to save the new image for e.g. Replace, Copy in input folder or Specify na
me and where to store it.
Then click Execute.
Display the new image in the main graphic window, and also display the multibeam data
or the surface created from the multibeam data.
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U. Workflows

Introduction

A workflow in Geocap is a way of combining datasets and actions or visualizations in sequence to produce
visualizations, movements and powerpoint style 3D presentations. The Atlantis Project is used throughout this
tutorial.

Exercises

Examine the workflows provided in the Atlantis_Mini project
Create a new workflow
Build the workflow
Create a flight tour

 

Exercise

Examine the workflows provided in the Atlantis_Mini project

In Geocap, click , and browse to the Atlantis_Mini folder, then open the theFile > Open > File
sub-folder called .Workflows
Double click on the file called  to open it, or single click to highlight itsample_workflow.gwf
and then click, . This will open the workflow below the project.Open
Examine the contents of the workflow items by clicking on the triangles next to the root folders.
Click on the Go to first executable element

icon and then click on the Execute next element

icon. This will display the seabed and land.
Click on the  icon again and notice that the 2500m isobath is displayed.Execute next element
Continue clicking on the  icon until you reach the end of the workflowExecute next element
and observe how different elements of the Atlantis_Mini project are displayed.

 

Workflows are saved as single files on disk with file extension *.gwf, (Geocap Work Flow). It is a good idea to
store them in a folder called   next to the   folder on diskworkflows db . In the next exercises we will create a new
empty workflow.

Exercise

Create a new workflow

Click .File > New > Workflow
Browse for the workflow folder or create a new one.
Give your workflow a name and click Save.
The new empty workflow window will pop up below the project.

 

We are now going to add different commands to our workflow. There are a number of ways to do this. You can
turn on the recorder and start executing commands and they will end up in the workflow or you can copy
commands from the Toolbox and paste them into the workflow. You can also add elements from the workflow
toolbar.

Note that the user may also execute each element one at a time by right clicking on the command and
choosing .Execute
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Exercise

Build the workflow

Press the  icon to create the first entry. That may also be achieved byNew Workflow Element
a right-click .New Element
Select the  command found in the  folder and click .Display Commands OK
Right-click the  command in the workflow and select .Display Edit
In a workflow, you will need to select a dataset from the project. The command usually
requires a dataset to do an action on (such as a type of display).
In your project, select a line and click the green arrow in the Display edit menu.
Choose the display settings you like (color, glue to surface or not, etc.) and click  again.OK
Right click the element in the workflow and choose . Alternatively, click the  icExecute Execute
on.
Examine how your display looks and edit the command if necessary to achieve the results you
want by right clicking on the command and choosing .edit
In order to keep your workflow organized it is recommended to change the name of the newly
added commands from  to something more descriptive like, Display Display Coastline Yellow
which is done by right clicking the command and choosing .Rename
Continue to add different commands to your workflow.
Remember to save the workflow by clicking the  icon.Save Workflow

 

A flight tour collects a series of camera positions and moves the camera smoothly through these positions. In
order to create a camera position all you need to do is right click a folder and select New > Camera Position.

Exercise

Create a flight tour

In your project, create a new generic folder called Cameras
Zoom to an area you want to save as a camera position.
Right click the folder  and select Cameras New > Camera Position
Repeat the last two steps to create more camera positions.
Select the  folder in your project.Cameras
In the go to , right click  and selectToolbox Shared Commands > Visualization   Flight Tour  C
opy.
Paste the command into your workflow. The command will open and it should have selected
the  folder as input. Cameras
Set the flight time between every camera position to  seconds and make sure 5 Collect

 and  is checkedcameras in folder to smooth flight tour Single flight tour
Click OK
Select the  command in the workflow and click the  icon toFlight Tour Execute next element
run the flight tour.

Commands may also be copied from ,  and  aShared commands Item commands Schema commands
nd pasted into the workflow.

To update a camera position, set the view in the graphics window, right click the camera
position and select Assign View.

It is possible to group elements in a folder. Add folders by clicking  on theNew workflow element
workflow toolbar and selecting  under Group General .
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V. PostScript Plotting

Introduction

Geocap has a plotting system utilizing the PostScript language. The plotting system enables you to create
scaled maps containing axes, scale bars, contour maps, lines, points, legends and anything else you might
need.

 

Exercises

Open and run a saveset in the plotting system
Explore the different plotting options

  

Note that you will have to install Ghostview and Ghostscript in order to make the plotting system work.
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Open and run a saveset in the plotting system

Exercise

Open and run a saveset in the plotting system

To open the PostScript plotting panel go to *Tools > PostScript Plotting.
Click .File > Read saveset
Browse for the saveset in the plotting folder under the  project on your disk.Seafloor_Training
Click Generate Draft.
When asked if you want to overwrite existing plot, click .Continue
When the plotting has finished click .File > View Plot in Ghostview

Ghostview should pop up and show your plot.

 

Explore the different plotting options

Exercise

Explore the different plotting options

Try clicking on the different check boxes to open the settings menu for each option.
Try to change some values and re-run the plot to see the changes.
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W. How to make charts in ArcMap

Introduction

This document is a description on how to print maps or charts in ArcMap Basic. The examples are typical data
exported from Geocap Seafloor. 

This document is not meant to replace any training courses in using ArcMap. The intention is to have a short
guide on how to create map layouts, import data and define the symbology (graphic attributes) for rasters,
points, lines and polygons. Additional knowledge about using ArcMap is recommended.

Some of the texts and images in this document are ArcGIS Desktop 10.3 Help texts.
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How to create map documents

A map document is containing the layout for a map to be distributed or printed. The document is saved as an
.mxd file type.
The document contains data frames, text boxes, static or dynamic texts, legends, north arrows etc.
The data frames contains the displayed geographical data symbolized as lines, points, symbols and labels. The
data storage for the displayed data can be files on a disk or from one or more geodatabases.

Open a new map document

To create a new map document, open the   menu and select   to open the   dialog.File New… New Document
Under My Templates there will be one template named Blank Map.
Under   several templates can be found. For instance, select ISO A3Standard Page Sizes > ISO (A) Page Sizes
Landscape and click OK to close the New Document dialog.
The document will be opened with one data frame named Layers in the Table Of Contents.
The new map document can be saved first time to the disk by File > Save. Browse to the correct folder and
specify a name for the map document and click Save. The file type will be .mxd.

Layout View and Data View

The map document can be viewed in two modes. In the   menu, find the   and the  :View Layout View Data View

Layout View is showing the whole document where all map elements and map data are available.
Data View shows the data in the data frame only and not the entire map content. If the map document
contains several data frames, the contents of the active data frame will be shown.

Modify the main data frame

When creating the new map document there will be a default data frame named Layers.
By double clicking the text   the name of the data frame can be modified. Layers
Another method is to right-click the Layers and select Properties. In the Data Frame Properties click the General
 tab. There the name of the data frame can be modified. For instance, type in the text   andMain Data Frame
click Apply.

Add and display data in the data frame

To add data in the data frame right-click the data frame and select Add Data… to open the Add Data dialog.
Browse and select the data from disk or from a geodatabase. It is also convenient to open the Catalog window
and locate the data objects directly and drag the data item and drop either into the data frame in the graphics or
into the Table Of Contents.
The symbolizing of the data can be set in the Properties dialog for the layer.

Set coordinate system

If no coordinate system is defined before adding data the data frame will get the same system like the first data
set. If the coordinates are geographic the data frame will select the same geographic (e.g. WGS84), and if they
are in a projection the data's datum and projection will be used (e.g. UTM 34N, WGS84).
To ensure the correct coordinate system, open the   dialog (right-click and selectData Frame Properties
Properties…) and select the   tab. To set a projected coordinate system, click ProjectedCoordinate System
Coordinate Systems + UTM + WGS 1984 + Northern Hemisphere, and select the item WGS 1984 UTM Zone

. Click Apply to set the coordinate system. Before leaving the Coordinate System tab it is possible to34N
right-click the WGS 1984 UTM Zone 34N system and select Add To Favorites. Then the system can be found in
the Favorites folder over the Geographic Coordinate Systems folder.

Set position and scale

The position of the data frame can be set in the   tab. Enter the position of the Anchor Point,Size and Position
given in mm from the lower left corner of the map document.
The size of the frame is defined in the Size part of the tab. Set width and height in mm.
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The scale of the data frame is set in the   tab. The Extent can be defined as  , Data Frame Automatic Fixed Scale
 or  .Fixed Extent

Automatic will set the scale and extent from zooming and panning inside the map frame.
Fixed Scale will lock the data frame to the given scale, for instance 1:1000. Select the scale value from
the dropdown menu, or write it as text in the Scale field. The part "1:" can be omitted. When using Fixed
Scale it is not possible to zoom in and out of the map frame.
Fixed Extent means specify the coordinates for the lower left and upper right corners. The scale is
calculated from the given coordinates and the size of the data frame in mm. When using Fixed Extent it is
not possible to zoom and pan.

Geographic graticule and Cartesian grid

To apply geographic graticule and/or a projection grid is done in the   tab in   dialog.Grids Data Frame Properties
The final layout of both the graticule and the grid can be changed after the initial setup.

Geographic graticule

Click the New Grid… button and open the Grids and Graticules Wizard. 
Select Graticule and click Next. 
In the Create graticule dialog, select, for instance, Graticule and labels, and specify Intervals for parallels and
meridians and click Next.
In the Axes and labels dialog click text style button for selecting font size and style. After closing the Symbol
Selector dialog, click Next.
In the Create a graticule dialog select Place a calibrated border at edge of graticule. Specify the Properties, for
instance Fill color is black, Void color is white, Width is 5 points, Interval 72 points and Use double alternating
border. Check the Graticule Properties part and use the Store as a fixed grid that updates with changes to the
data frame. Click Finish.
To view the Graticule grid click Apply in the Data Frame Properties dialog. 
To edit the Properties of the Graticule, highlight the Graticule in the Grids tab and click the Properties... button.
Check the tabs Axes, Labels, Lines and Intervals.

Cartesian grid (UTM grid)

Click the New Grid… button and open the Grids and Graticules Wizard. 
Select Measured Grid and click Next. 
In the Create a measured grid dialog, select, for instance, Grid and labels, and specify Intervals for X Axis and Y
Axis and click Next.
In the Axes and labels dialog click text style button for selecting font size and style. After closing the Symbol
Selector dialog, click Next.
In the Create a measured grid dialog select Place a border outside the grid. Check the Grid Properties part and
use the Store as a fixed grid that updates with changes to the data frame. Click Finish.
To view the Measured Grid click Apply in the Data Frame Properties dialog.
To edit the Properties of the Cartesian grid, highlight the Measured Grid in the Grids tab and click the
Properties... button. Check the tabs Axes, Labels, Lines and Intervals.

Create an Index Map

The Index Map is just another data frame. The new frame is created by opening the   menu and select Insert Dat
. The New Data Frame is positioned in the middle of the map layout. By using the mouse the frame cana Frame

be selected and resized.
Detailed specification for the size, position, coordinate system and scale is set in the Data Frame Properties
dialog as discussed above.

Make non geographic boxes in the map

In the map we need to create boxes around texts and other content, like legends etc.
In the   menu select the   option.Insert Neatline
In the Neatline dialog click Place inside margins. Click the Border and select the style and thickness, for instance
0.5 points. If the   icon is clicked the thickness can be changed to 0.1 points if wanted.i
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When clicking OK the neatline (box) will be created along the edge of the page area. The box can be resized
and moved with the mouse.
When right-clicking the selected frame, the Properties for the neatline (box) can be opened. In the tabs  , Area Fr

 and  , the properties can be changed. Set the position of the anchor point (default isame Size and Position
lower left corner) and the width and height of the box.
When making several identical boxes it is possible to copy and paste the box, and then set the correct position
of the anchor point of the new box.
It is also possible to select several boxes and set the lower left corner for the group of boxes.

Insert texts

In the   menu select the   option.Insert Text
The text is created somewhere in the middle of the map. Locate the Text and move to the wanted position.
When right-clicking the selected text, the Properties for the text can be opened. In the tabs   and Text Size and

, the properties can be changed. Set the position of the anchor point (default is lower left corner) for thePosition
text can be specified here.
In the Text tab the text string can be entered. To set the font size and type, click the Change Symbol… button.
When making several texts with identical style is possible by copy and paste the text. Open the Properties by
double-clicking the new text or right-click and select Properties. Set the new text string and the correct position
for the new text. The position can also be set by moving the text with the mouse.

Dynamic texts

In the   menu select the   option, and select between different text content.Insert Dynamic Text
The Dynamic text is using information from the map document, like a data frame's scale and coordinate system,
current data and time, last saved time etc.
The changing of properties is equal as for a static text.
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How to export data from Geocap

From Geocap we have two methods for exporting data to ArcMap and other software.

Export as shapefiles or other formats.
Use the DataLink for ArcGIS to copy directly to an ArcGIS file geodatabase when using the 32 bit version
of Geocap.

Export to files

Each dataset also have an   entry on the right-click menu where different formats can be selected. Export

In Geocap Seafloor the data can be exported from the   folder by the commands   an2. Charts Export Chart Data
d  .Export Contours

Export Chart Data

The Export Chart Data command has the four tabs  ,  ,   and  .Polygons Points Surfaces Hill Shade
In each of the tabs, select which charts to export. For some of the formats there is an option to check the Lat/Lon
box when the coordinates should be exported as geographic.

From the   tab export the Frame and Boundary polygons for the selected chart(s). The bestPolygons
output format is   (as Polygon Feature).Esri Shapefile Polygons
From the   tab export the Seafloor surface as points for the selected chart(s). The best outputPoints
format is   (as Point Feature).Esri Shapefile Points
From the   tab export the Seafloor surface for the selected chart(s). The best output formats are Surfaces

 and  .Bathymetry Attributed Grid (BAG) Geo TIFF
From the   tab export the Seafloor surface as a hill shade image for the selected chart(s). TheHill Shade
output format is  .Geo TIFF

Specify the output directory for the files by clicking the browse button and select folder.
The file name will (for instance) be  . If the file already exist it can beSurfacepoints_<Chart Name>.shp
overwritten or a new version can be created. A prefix to the filename can be specified in the input field.

Export Contours

The Export Contours command has the two modes, export as   or  . For ordinaryContour Lines Contour Areas
contour lines, select the first mode.

In the Chart Name part, select from which charts to create the contours.
Select the contouring method (Increment) and the increment value.
Check the Lat/Lon box when the coordinates should be exported as geographic. The option is not
available for all format types.
Select if the contours should be saved to a file, to the project, or both. The project object will get the name
Contours.
Select Export Format. The best output format is   (as Line Feature).Esri Shapefile Contours
Specify the output directory for the files by clicking the browse button and select folder.
The file name will (for instance) be  . If the file already exist it can beContours_<Chart Name>.shp
overwritten or a new version can be created. A prefix to the filename can be specified in the input field.
The contours in the shape file will have the same layer name for all contour line levels. If some contours
(for instance every 5 ) should be displayed with different line width, it is necessary to do the export 2th

times with the different increments, for instance 1 meter and 5 meter increments. When later creating
annotation on the contour lines, the operator can decide which contour data set to use, if all contours
should have annotation or just every 5 .th

Export to ArcGIS file geodatabase using the DataLink

The export to the ArcGIS file geodatabase requires a license of the module    . TheGeocap DataLink for ArcGIS
feature in the license file will have the name "gis". 

On the computer the ArcMap (ArcGIS) program must be installed and have a valid license.
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To run the module the 32-bit version of Geocap must be started, since ArcGIS is a 32-bit application.

Activate the Geocap DataLink for ArcGIS

From the Geocap main window select Tools > Options …

In the   menu select   in the left part. In the Plug-ins part, check the box for Options Plug-ins DataLink for ArcGIS
.

Below the Plug-ins part the ArcGIS version must be selected. The latest version is 10.3.

Then click the Apply or OK buttons to activate the module. Next time Geocap is started after exit, the module will
be automatically loaded. If the 64-bit version is started, the module will just be ignored.

Create datasets for copying

One of the preparations before the copying is to create the datasets which should be presented in the map.

Boundary: Execute the   command to create the Boundary dataset (outline)Make Boundary and Holes
around the input points or the generated surface (Seafloor).

Contours: Execute the   command to create a Contours dataset for the chart. Note thatExport Contours
if you want to have two contour data sets (see the text in section  ) the command mustExport Contours
be executed two times, and the first Contours data set must be renamed before executing the command
the second time.

Surfacepoints (Seafloor surface as points): Execute the command Export Chart Data and go to the
Points tab. Select the option Seafloor surface as points, and also select Save in project only. When
clicking Execute the Surfacepoints data set is created for the selected chart(s).

Create or open an ArcGIS file geodatabase

The ArcGIS file geodatabase can be opened as an object in a Geocap project. So before you can open a
geodatabase the Geocap project must be loaded.

Click the arrow next to the 

   icon in the project toolbar, and open the menu:

If the ArcGIS file geodatabase already exist, click Add Data Source in the menu. Set Datasource to File
Geodatabase and click the Browse button for the correct database (folder). When clicking the Connect
button the database is opened in the project tree.
To create a new file geodatabase, click Create ArcGIS File Geodatabase. In the dialog which appears
select   or  . If the database is to be shared, it is recommended to create itIn project Outside project
outside the Geocap project. Browse to the proper folder. Then, in the Name field, enter the name of the
database (for instance myChart). Click OK to create the database.

Copy data to the ArcGIS file geodatabase

To copy data from a Geocap project to an ArcGIS file geodatabase is done from the right-click menu option Cop
 on the selected data items. It is possible with multiple select and also different data types. In addition to selecty

data in the list view, it is also possible to use the Multiple > Copy from a folder in the project.

Click on the file geodatabase (for instance myChart) in the project tree, right-click and select  .Paste

Then a menu opens for setting parameters for the different datatypes Points, Lines and Surfaces.
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Copy Point data as:

Export as   or  . To copy as Multipoint Feature it will be faster to copy thePoint Feature Multipoint Feature
data, but if the each points will be labeled with depth value, the   class is required.Point Feature
Add Z value of points as fields in feature class: To be able to print the depth value in a map, the Z
value must be a column in the attribute table.

Copy Line data as:

Export as  ,   or  .Line Feature Contours (Line Feature) Polygon Feature
In ArcMap line data are defined in two types of features: Lines Features and Polygon Features. Lines
(polylines) are open-ended lines, and Polygon Features are closed lines defining an area. A polygon is
always connecting the last point to the first point in the line. Geocap not differ on line data, and do not
check if it the lines are open or closed.
The selected feature type is dependent on the data to copy. For instance, the   and   dataFrame Boundary
sets should be copied as  , while the contour lines should be saved as Polygon Features Contours (Line

.Feature)
The   option stores the lines as line features even if there are closed contours inContours (Line Feature)
the data set. The contours are sorted on increasing depth to easier check the depth levels in the dataset.
Each line element will also be saved as a row in the ArcGIS data table. This makes it possible to use the
Editor tool in ArcMap to select and edit or delete small contour lines.

Also export to Point Feature class: When turning on this option the lines data can also be copied as a
point data set with the postfix _  in the feature name. This is necessary if any attributes of points inpoints
the line should be used in the map document.

 

The next options are appropriate for all data types, both  ,  ,   and  .Points Lines Polygons Rasters

Vertical Options:

Flip Z values means that the z values in the data geometry is multiplied with -1 to convert to elevation
(height) with positive values upwards, instead of depths with positive value downwards.
Set Vertical Coordinate system: When vertical reference system is known it can be defined by using
this option. The system can be an elevation or a depth system. First select the region (Africa, Asia,
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Europe, World etc), and then a system in the region.
If a depth system is selected the Z values do not need to be flipped. 
Note: The option only sets the actual vertical reference system and no shift between the systems is
performed. 

Target database: The name and path to the database selected for copying to.

 

Output Spatial Reference:

Set the horizontal coordinate system for the data. The information box will contain the coordinate system
of the first selected data object which is copied. The Geocap geodetic properties are translated into the
ArcGIS definition. If a vertical reference system is defined it will appear after the horizontal system.
Click the Browse button to open the dialog to set the spatial reference.

Note: The selected vertical and spatial reference will be set on all the selected data sets. If the selected data
items have different coordinate systems, for instance projected and geographic, the copying should be done in
two operations. In ArcMap the data will automatically be transformed to the projection in the data frame during
display and plotting, so it is no problem to have data with different coordinate systems in the same database.
Click   to start the copying. Large point data sets copied as Point Feature may take some time. OK
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How to add layers to a map (in ArcMap)

Adding a dataset

To create a new map layer, simply add a dataset to your map, globe, or 3D scene. There are a few ways to add
datasets:

Using the Add Data button — Click the   button  Add Data

  and navigate to the desired dataset. Then select and add it to your map.

 

Copying or dragging a layer — You can move layers between data frames or maps by copying and
pasting or dragging the layer from one data frame to another.

Dragging a dataset from the Catalog window — You can navigate to datasets and add them directly in
ArcMap. Using the   window, navigate to the desired dataset. Drag the dataset into the map's dataCatalog
frame.

All datasets which are recognized by ArcMap can be copied or dragged into the active Data Frame this way. If
the dataset is an excel file it will appear as a table in ArcMap. Also, if the dataset is an ascii file it will also appear
as a table when dragged into ArcMap.
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Adding data from Geocap Seafloor

1. From shapefiles

In the Catalogue window, browse to the folder where the exported shapefiles are located. See the files with
Surfacepoints, Contours, Frame, Boundary and Seafloor etc, and drag the files into the active data frame.

2. From file geodatabase

In the Catalogue window, browse to the folder where the database myChart.gdb is located. Open the database
and see the data items copied into the database. To be sure to that all data items are shown, click the 
How to symbolize the data layers will be discussed later in the document.

Adding an ASCII or text file table

In ArcGIS, you can directly access data in delimited text files and work with them as tables. ArcCatalog and the 
 dialog box in ArcMap list files with .txt, .asc, .csv, or .tab extensions and assign them a file type of textAdd Data

file.

Files with a .txt, .asc, or .csv extension are interpreted as comma (or semi-colon) delimited, while files with a .tab
extension are interpreted as tab delimited by default. Any file with one of these extensions will be interpreted as
a text file table even if it doesn't contain tabular data. If you attempt to display a text file that doesn't contain
tabular data, the software will either produce an error or attempt to display the data as a table. To avoid this
problem, give your delimited text files a .csv or a .tab extension. This will help differentiate text files with
delimited data from unformatted text files.

The first row of your text file can contain the column headings. The following rows can contain coordinates and
attributes. Remember to use commas or tabs to distinguish the columns. The following is an example of a
comma-delimited text file:

x,y,ID,color
8.6,5.6,001,blue
99.3,77.0,002,blue and red
8.01,44.3,003,orange

This can be previewed in ArcCatalog or added as data in ArcMap and will appear as shown:

To convert the table to a geographic layer you will need to run a geoprocessing tool.
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Convert data with the Make XY event layer tool

Having a data in a text file (ascii) the best way to import the information is from a semi-colon separated file with
file type  . The coordinate system can be in geographic or in a projection..csv

The .csv file must have a header row for specifying the columns, for instance "Latitude; Longitude; Label":

Latitude; Longitude; Label
54.38228614; 18.65559966; 1
54.38222022; 18.65523383; 3
54.38215409; 18.65486909; 5
54.38208797; 18.65449803; 7
54.38202205; 18.65413099; 9

In any ArcGIS for Desktop application, you open the ArcToolbox with the ArcToolbox Window button 

 found on the standard toolbar or by clicking   >  .Geoprocessing ArcToolbox

To import the points and the labels we will use the   tool. If you have more than one dataMake XY Event Layer
frame in your map document, check which data frame is active, if it is the Index map or the main map.

The tool is opened from the ArcToolbox window:

Data Management Tools > Layers and Table views > Make XY Event Layer 

 

The menu will have these input fields:

XY Table: Browse to the correct folder and select the .csv file containing the points and labels.

X Field: Latitude (or X if the file has Cartesian coordinates.)

Y Field: Longitude (or Y)

Z Field (optional): Set blank if the file does not have a Z column.

Layer Name or Table View: The name of the output point event layer. Will by default be the data file name
without .csv.

Spatial Reference (optional): The spatial reference of the coordinates in the X and Y Fields defined
above. This will be the output event layer's spatial reference. It is recommended to set the spatial
reference.

 

Click   to read the input file into the map document.OK
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How to symbolize data in the map

The layers in the data frame can be symbolized and presented in different ways according to the geometry type.
Lines can be symbolized as lines only, polygons (areas) as closed lines and colourfill/hatching, points with
symbols and labels. Rasters (grids and images) has another type of symbology.

Points with symbols and text labels

Some labels in the map will contain symbols which represents the point position, and a text numeric label which
should be annotated close to the symbol.

The simplest is to import the information from an ascii file, and the best way to import the information is from a
semi-colon separated file with file type  . The coordinate system can be in geographic or in a projection..csv

The .csv file must have a header row for specifying the columns, for instance "Latitude; Longitude; Label":

Latitude; Longitude; Label
54.38228614; 18.65559966; 1
54.38222022; 18.65523383; 3
54.38215409; 18.65486909; 5
54.38208797; 18.65449803; 7
54.38202205; 18.65413099; 9 

The data points can be imported to the map document by the   tool.Make XY Event Layer

1. Apply a symbol

Find the new layer and open the Properties dialog for the layer. In the Layer Properties dialog, click the
Symbology tab and click the Symbol icon. In the Symbol Selector dialog, click Edit Symbol to open the Symbol
Property Editor. 

In the Symbol Property Editor the properties type should be  . In the Character MarkerCharacter Marker Symbol
tab below there are a lot of ESRI font sets. Some useful symbols can be found in the   fontESRI Default Marker
set (for instance the symbol P). Many hydrographic symbols can be found in the font set   (diESRI NIMA DNC PT
gital nautical chart, points). Another useful font set is  . ESRI Geometric Symbols

It is possible to create a new symbol by combining two or more symbols from different font sets.

When clicking Apply in the Layer Properties dialog, the symbol plotting will start.

2. Apply the Label

In the Layer Properties dialog, click the Labels tab.

In the Text String box, set the Label Field to the name from the third column in the input file: Label.

In the Text Symbol box, set the font type, font style, color and size.

Click the Placement Properties button and open the dialog. In the Placement tab, select the option Offset label
. This will plot the label with the on the specified side of the point's position. Clickhorizontally around the point

the   button to change the labels' position around the points.Change Location

 
Some optional locations:
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In the Conflict Detection tab the parameters for overplot removal can be adjusted. Check the Label weight and
the Feature weight options. Click OK to close the Placement Properties dialog.

In the Labels tab in the Layer Properties dialog, check the box ahead of Label Features in this layer. When
clicking Apply or OK the label plotting will start.

Note: If the Placement Properties dialog has more the two tabs, we have to change the settings for the data
frame. Enter the properties for the data frame and click the General tab. In the lower part there is a selection of
Label Engine. Select the Standard Label Engine and not the Maplex Label Engine.

Hydrographic Depth Annotation

Add the Surfacepoints dataset from the geodatabase to the active data frame.

The default symbolization is a coloured filled point symbol with outline with size 4 points.

Open the Surfacepoint's   dialog (double-click or right-click and select Properties).Layer Properties

Click the   tab and then double-click on the symbol. In the Symbol Selector dialog, select the symbolSymbology
named Circle 1, and set the Color to No Color. Click OK to finish the dialog.

Click the   tab and do the following:Labels

In the Text String box, set the Label Field to  . (If Z is missing the export from Geocap or the import toZ
ArcMap has not been properly).

Click the Placement Properties button and open the dialog. In the Placement tab, select the option Place
. This will plot the label with the geometric center of the point's position. In thelabel on top of the point

Conflict Detection tab the parameters for overplot removal can be adjusted. Click OK to close the
Placement Properties dialog.

Note: If the Placement Properties dialog has more the two tabs we have to change the settings for the
data frame. Enter the properties for the data frame and click the General tab. In the lower part there is a
selection of Label Engine. Select the Standard Label Engine and   the Maplex Label Engine.not

To have the Hydrographic Annotation we have to enter a formula:
Click the Expression button and open the Label Expression dialog.
In the lower part, click the Load button. Browse to the file Hydrographic_Z_labels_0_21_31.lxp and
click open. The file contains this expression:
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Function FindLabel ( [Z] )
' Generate depth labels according to IHO CHART SPECIFICATIONS,
' Edition 4.4.0 – September 2013:
' Soundings must be rounded down, if necessary. The rounding
should be:
' · to the nearest decimetre between 0,1 and 21m,
' · to the nearest half metre from 21 to 31m and,
' · thereafter, to the nearest metre.
dim decimeters
dim meters
dim decimal
decimeters = int( [Z] * 10 )
meters = int( decimeters / 10 )
' ** Deeper than 31 meters, label the meter values only **
If meters >= 31 Then
FindLabel = meters
' ** Generate label with meters only **
FindLabel ="<FNT name = 'Arial' size = '7' > " & meters & "
</FNT>"
Else
' ** Between 21 and 31 meters, cut decimal to 0.5 meter,
shallower ** 
' ** Between 0 and 21 meters, cut decimal to 0.1 meter,
shallower **
decimal = int ( decimeters - meters*10 )
If meters >= 21 Then
If decimal>=5 Then
decimal = 5
Else
decimal = 0
End If
End If
' ** Generate label with meters and decimals. If decimal is
zero it shall not be shown
If decimal > 0 Then
FindLabel ="<FNT name ='Arial' size = '7'> " & meters &
"</FNT><FNT name ='Arial' size = '9'><SUB>" & decimal &
"</SUB></FNT>"
Else
FindLabel ="<FNT name ='Arial' size = '7' > " & meters & "
</FNT>"
End If
End If
End Function

The expression can be modified and saved to a new file by the Save button.
Note that the font type and font size is defined in the expression. The font is Arial and the size is 7.
The lowered decimal is printed as a subscript font, but with size 9 pts to make it not too small.
Click OK to finish the Label Expression dialog.

In the Labels tab in the Layer Properties dialog, check the box ahead of Label Features in this layer.
When clicking Apply or OK the label plotting will start.

The labeling of the   layer can also be turned on and off by the checkbox ahead of the layerSurfacepoint
name. Also right-click the layer and turn on and off Label Features.
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Points with Hydrographic Symbols

Plotting Hydrographic symbols can defined by opening the Properties dialog for the layer. For example the buoy
symbol IHO_Q5_B can be set up by combining two symbols (fonts).

In the Layer Properties dialog, click the Symbology tab and then click the Symbol icon. In the Symbol Selector
dialog, click Edit Symbol to open the Symbol Property Editor.

In the   the properties type should be  . In the CharacterSymbol Property Editor Character Marker Symbol
Marker tab below select the font   (fonts for Digital Nautical Chart, points).ESRI NIMA DNC PT

Select the isymbol and then add the s symbol. By combining the size and offset of the two fonts, the result can
be the hydrographic symbol 

 The dotted cross in the preview shows where the position of the symbol will be.

When clicking Apply or OK in the Symbol Property Editor, the Symbol Selector dialog, and then the Layer
Properties dialog, the symbol plotting will start.

Save and re-use a symbology

To save the symbol for use on other data sets later, close the Layer Properties dialog and right-click the layer
(data set) name and select Save As Layer File. This will save the layer definition and not the data as a .lyr file.

In the Save Layer dialog enter the file name, for instance buoys_IHO_Q5_B.lyr, and browse to a folder where to
save the definitions.

Next time the same symbol is to be used for a data set (layer), open the Layer Properties dialog, and click the
Symbology tab. To re-use the symbol, click the Import button up to the right. Click the browse button and add the
saved .lyr file to the Layer pulldown menu. Click OK to select the symbol definition.

Use the same method for all other point, lines and polygons symbology. Note that labels will not be set from the
layer definition. Enter the Labels tab to define the label style.

Contours

1. Create contour annotation with the Contour Annotation tool

To create the contour annotation and the gap in the contour lines, we will use the   tool. IfContour Annotation
you have more than one data frame in your map document, check which data frame is active, if it is the Index
map or the main map.

The tool is opened from the ArcToolbox window:

Cartography Tools > Annotation > Contour Annotation

 

The menu will have these input fields:

Input Features: Contours (when copied from the file geodatabase)

Output Geodatabase: C:\ArcGIS\MyChart\myChart.gdb

Contour Label Field: Z

Reference Scale: 1000 (the scale for the plot)

Output Layer Name: Contours_layer

Contour and Label color: BLACK

Contour Type Field (optional): (no value)
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1.  
2.  
3.  

Contour Alignment (optional): PAGE (or UPHILL)

Enable Laddering (optional): Yes (Check this box)

 

Click   to create the contour annotation features into the map document.OK

2. Set drawing properties on contours and annotation

Use    List By Drawing Order

   in the table of contents to author the contents of your map, such as to change the display order of layers on
the map, rename or remove layers, and create or manage group layers. 

A new group layer, Contours_layer, is created containing these feature layers:

Contour Features: Contains contour lines. Set the line properties by double-clicking the automatic
generated line symbol.

Note: This dataset is not saved in the output geodatabase. Can be saved by right-clicking, select Data >
Export Data… Click the browse button to select which folder or file geodatabase to save the data layer,
and specify the name.

Contour_FeaturesAnno: Contains the annotation labels. The properties can be changed by using the Edit
 tool. The dataset is saved in the output file geodatabase.or

Contour_FeaturesAnnoMask: Contains the mask to clip holes in the contour lines. Change the Symbology
(on the Layer Properties) to be white text without line around. The dataset is saved in the output file
geodatabase.

 

The drawing order must be changed to:

Contour_FeaturesAnno
Contour_FeaturesAnnoMask
Contour Features

3. Change font size for annotation labels

The font style for the annotation labels is changed with the Editor tool. The Editor should not be active before
starting.

From the   layer, right-click and select Contour_FeaturesAnno Selection > Select All.
Then again from the   layer, right-click and select   OftenContour_FeaturesAnno Edit Features > Start Editing.
a dialog with an error message appears, just click the Continue button.

Then locate the   toolbar and click the menu arrow and select  . TheEditor Editing Windows > Attributes
attributes window appears on the right side of ArcMap. The attributes window contains the name of the layer,
Contour_FeaturesAnno, and the list of the annotation labels. To change the style for all labels, mark the top text
(Contour_FeaturesAnno). Click the Annotation tab below, and in the lower part the font style can be changed.
Click Apply to set the new style.

When finished, locate the   toolbar, click the menu arrow and select  . Confirm that the editingEditor Stop Editing
is saved.

If the Editor toolbar is not visible, click  , and check the box for the Editor toolbar.Customize > Toolbars

Lines and polygons

Data sets of type Lines and Polygons can change symbology by opening the Properties dialog form the data
layer.
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Lines can be symbolized by the line color, thickness and pattern.

Polygons can be symbolized with different types of fill patterns and colors, and with or without the outline.

Rasters (surfaces)

Raster data s can change the symbology by opening the Properties dialog from the data layer. As default the
raster is displayed using a greyscale color table. A change of the color table can be done by double-clicking the
table in the Table Of Contents. Then, in the Select Color Ramp dialog the color table can be changed.

To do some more detailed changes, open the Layer Properties dialog.

First, open the   tab. Change the option " " from Nearest Neighbor to Display Resample during display using: Bil
 (or Cubic Convolution). This will make the color coding smoother for continuous data. Alsoinear Interpolation

check that the option " " is set to  .Display Quality: Normal

Then, open the   tab. The default display method is  . If that is ok, the color table (Symbology Stretched Color
) can be changed also here.Ramp

To make color levels with fixed increment, change the Show method from Stretched to  . First time theClassified
Compute Histogram dialog appears. Click the Yes button to compute the histogram. By default 5 classes are
created. Click the   button.Classify…

In the Classification dialog, change the Classification Method to  . Enter the interval sizeDefined Interval
(increment) to (for instance) 1 m. On the right hand side of the histogram the break values appear. Click the OK
button when they seems correct. Back in the Symbology tab in the Layer Properties the color legend is shown.
In the Label part the text for the labels in the color table can be edited. The colors are changed when changing
the color ramp (color table), and the can also be changed individually by double-clicking the colored rectangle.
Click Apply to see the changes in the Table Of Contents and to see the color code raster.

If the message "Classification failed. Please choose different data or classification method" appears, the problem
is that the difference between the minimum and maximum value is too small for the default settings. If 1 meter
interval size do not work, try 0,5 m. To force the classification to be with the correct number of intervals, select
the method  , for instance 2. In the list of the break values, change the values to be the exact levelEqual Interval
for the color change. If the depth values in the raster are from 10,03 meters to 11,86 meters, change the break
values to be 11 and 12. Click OK in the Classification dialog and see the color table in the Symbology tab of the
Layer Properties. Check the color symbols and labels before clicking Apply or OK in the Layer Properties dialog.

Create circles in the map

Creating new datasets based on other geographic element can be done using the Geoprocessing tools. For
instance, to create a circle around a given position, use the Buffer tool.

As an example a circle with radius 50m should be created around the point "54.38161998, 18.65444449". The
coordinates are given in WGS84 as longitude/latitude, while the map projection is WGS84, UTM Zone 34N.

To import the circle center, create a .csv file named circle_point.csv:

Latitude; Longitude
54.38161998; 18.65444449 

Verify that the correct data frame is active, and use the   tool to import the data and createMake XY Event Layer
a new layer named   in the map.circle_point

 

To run the Geoprocessing tool, the circle_point must be converted to a Feature Class in by exporting the data
from the layer to a geodatabase:

From the new circle_point layer in the map document, right-click and select Data > Export Data…

In the Export Data dialog set "Use the same coordinate system as: this layer's source data.

Set Output feature class to, for instance: C:\ArcGIS\MyChart  and click myGeodatabase.gdb\circle_point
. Now the feature class circle_point is created in the database. Say yes to create a layer in the mapOK

document.
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To create the circle around the point, click   and then   tool:Geoprocessing Buffer

The menu will have these input fields:

Input Features: C:\ArcGIS\MyChart\myGeodatabase.gdb\circle_point

Output Feature Class: C:\ArcGIS\MyChart\myGeodatabase.gdb\ circle_buffer

Distance [value or field]: Use   , 50 meters.Linear unit

Side Type (optional)

End Type (optional)

Method: PLANAR (option GEODESIC for very large radius only)

Dissolve Type (optional): NONE

Dissolve Field(s) (optional)

Click   to create the circle and save the circle_buffer in the file geodatabase myGeodatabase.gdb. In the mapOK
document also the layer circle_buffer is created. Open the Layer Properties to set and change the symbolization
fir this circle.

Transform a point from geographic to a projection

The coordinates of the circle_point above are Geographic (WGS84). To transform to a new feature class in
WGS84, UTM Zone 34N, we can use the tool  :Project

The tool is opened from the ArcToolbox window:

Data Management Tools > Projections and Tranformations > Project

The menu will have these input fields:

Input Dataset or Feature Class: C:\ArcGIS\MyChart\myGeodatabase.gdb\circle_point

Input Coordinate System (optional) (Use the information from the dataset)

Output Dataset or Feature Class:

C:\ArcGIS\MyChart\myGeodatabase.gdb\circle_point_utm34n

Output Coordinate System: WGS_1984_UTM_Zone_34N (use the browse button)

Geographic Transfomation (optional)

 

Click   to create the new feature class.OK

In the database C:\ArcGIS\MyChart\myGeodatabase.gdb, locate the feature class circle_point_utm34n,
right-click and select Properties. In the Feature Class Properties dialog, select the   tab. Since theFeature Extent
feature class contains one point only, the extent will be equal to the coordinates of the point: X: 347673.2274, Y:
6028517.4613.

Digitize new lines in the map

Before starting digitizing new data into the map and a file geodatabase a new feature class must be created.

Locate the actual database in the Catalog window, for instance the myGeodatabase.gdb.

Right-click and select New > Feature Class…

In the New Feature Class wizard, specify the

Name: new_line_feature (as an example)

Alias: (leave empty)
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Type: Line Features (if the feature class should be a line)

Geomentry properties: (use default)

Click the   button :Next>

The wizard continues with the coordinate system for the feature class. Set for instance the same as the
map projection, for instance WGS84, UTM Zone 34N. Note that the Layers folder in the wizard shows the
coordinate systems for the layer in the map document.

Click the   button :Next>

Verify the XY Tolerance.

Click the   button :Next>

Verify the database storage configuration.

Click the   button :Next>

Verify the database attribute table.

Click the   button.Finish

 

The layer   is created as an empty layer in the document and also as a feature class in thenew_line_feature
database.

For instance, to create a line showing the diameter in the circle created above, we need to digitize one point on
the circle circumference on each side of the circle center with coordinates X=347673.23, Y=6028517.46. The
new points should be: 1) X=347623.23, Y=6028517.46 2) X=347723.23, Y=6028517.46.

Locate the new_line_feature in the map document layers, right-click and select   Edit Features > Start Editing…
Often a dialog with an error message appears, just click the Continue button.

Then the Create Features window appears to the right of the graphics window. (Or locate the   toolbar andEditor
click the menu arrow and select  .)Editing Windows > Create Features

Select the new_line_feature in the table of features, and then, under the  , select the   toConstruction Tools Line
ol. When moving the cursor to the graphics window, the cursor changes to a cross for digitizing mode. Using the
leftmost mouse button the coordinates can be taken from the mouse position. When right-clicking the coordinate
can be snapped to another element or the absolute X,Y coordinate. Select   and the Absolute X,Absolute X,Y…
Y window opens with the coordinates from the cursor.

Enter the coordinates (X: 347623,23, Y: 6028517,46) and click the Enter key on the keyboard.

Again, select   and the Absolute X, Y window opens with the coordinates from the cursor.Absolute X,Y…

Enter the coordinates (X: 347723,23, Y: 6028517,46) and click the Enter key on the keyboard. (Note: It is also
possible to use Delta X,Y values from the first point instead of absolute X,Y).

To end the digitizing session, right-click and select Finish Part. Then a new line can be created.

To finish all the digitizing, right-click and select  .Finish Sketch

Then locate the   toolbar and click the menu arrow and select  , and verify that the EditsEditor Stop Editing
should be saved. Now the digitized coordinates are saved in the file geodatabase.

The symbolization of the layer in the map document can be changed in the Layer Properties dialogue.
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Essential ArcMap vocabulary

Map document (.mxd)

A map used in ArcMap that is stored as a file on disk. Each map document contains the specifications for the
map layers, the page layout, and all other map properties. Map documents make it easy to save, reuse, and
share your work in ArcMap. Double-clicking a map document opens it as a new ArcMap session.

 

Layer

A map layer defines how a GIS dataset is symbolized and labeled (i.e., portrayed) in your map views. Each layer
represents geographic data in ArcMap such as a particular theme of data. Example map layers include streams
and lakes, terrain, roads, political boundaries, parcels, building footprints, utility lines, and orthophoto imagery.

 

Table of contents

The table of contents lists all the layers on the map and shows what the features in each layer represent. The
check box next to each layer indicates whether its display is currently turned on or off. The order of layers within
the table of contents specifies their drawing order in the data frame from bottom to top.

The map's table of contents helps you manage the display order of map layers and symbol assignment, as well
as to set the display and other properties of each map layer.
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Data frame

The data frame displays a collection of layers drawn in a particular order for a given map extent and map
projection. The table of contents on the left side of the map window shows the list of layers in the data frame.

 

 

Page layouts

A layout is a collection of map elements laid out and organized on a page. Common map elements include one
or more data frames (each containing an ordered set of map layers), a scale bar, north arrow, map title,
descriptive text, and a symbol legend.
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The Catalog Window

ArcMap, ArcGlobe, and ArcScene include a Catalog window that is used to organize and manage various types
of geographic information as logical collections— for example, the data, maps, and results of your current GIS
projects that you work with in ArcGIS.

The   window provides a tree view of file folders and geodatabases. File folders are used to organizeCatalog
your ArcGIS documents and files. Geodatabases are used to organize your GIS datasets.

Labels

Labels are text strings that are used to label features within map layers. Properties define the attribute column
used as the source of the text string and how the label is portrayed in your map. Labels are dynamic — Label
display is recomputed each time the map is redrawn (e.g., as you pan and zoom the map).

 

Annotation

Annotation is used to represent feature labels that are saved as graphic feature locations in the geodatabase.
The text location is saved along with other text properties for each annotation feature. Annotation differs from
labels because each annotation location and depiction is only computed once and saved. These are reused
each time you redraw your map. Since the annotation position is preset, no label computation need be done
each time the map is redrawn.

 

Symbols

Symbols are graphic elements that are used in map displays. There are a number of symbol types, such as:

Markers which are primarily used to display point locations
Line symbols used to display linear features and boundaries
Fill symbols used to fill in polygons
Text symbols used to set the font, size, color, and other text properties.

Styles

A style is a collection of symbols, colors, and map elements that match a theme or application domain—for
example, a style set for transportation maps or geology maps.
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Basemap layers

A basemap is used for locational reference and provides a framework on which users overlay or mashup their
operational layers, perform tasks, and visualize geographic information. In ArcMap, a basemap layer can be
used to hold map layers that are more static and thus can be used to support high performance, dynamic map
display.
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Notes
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